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Introdução 1

Neste capítulo encontrará
• Descrição geral: página 1

• Assistência: página 3

• Dispositivos suportados: página 3 

• Como utilizar este guia: página 6

• Segurança do utilizador: página 6

Descrição geral

Agradecemos-lhe ter escolhido a Medtronic Diabetes como seu aliado 

para o ajudar a si e aos seus doentes na tarefa de melhor gerir 

a diabetes. Acreditamos que colherá vantagens da tecnologia de ponta 

do software CareLink™ Pro e do respectivo interface do utilizador simples
de utilizar, com base numa estrutura de menus.

Este guia do utilizador descreve como utilizar o CareLink Pro para captar, 

guardar e elaborar relatórios dos dados de diagnóstico e tratamento 

dos doentes. Descreve ainda a opção de aceder aos dados da bomba, 

do medidor e da glicose registada pelo sensor que os seus doentes 

enviaram para o CareLink™ Personal, um sistema de gestão da terapia 

com base na Web que funciona em conjunto com o CareLink Pro.
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Funções     

O CareLink Pro é um software de gestão da terapia da diabetes para 

instalar num computador pessoal (PC). Integra as seguintes funções:

• podem ser criados registos do doente para guardar os dados recolhidos 

do dispositivo do doente, além dos dados da terapia da sua conta 

CareLink Personal; 

• podem ser enviados dados das bombas de insulina, monitores e medidores 

de glicose no sangue para o sistema, onde são guardados e usados 

para elaborar relatórios;

• como característica opcional, é possível efectuar uma ligação ao 

sistema CareLink Personal para aceder aos dados do dispositivo que 

o doente aí tiver guardado. Esta é a forma ideal de criar relatórios 

actualizados entre consultas, podendo eliminar a necessidade de ler 

os dados do dispositivo durante as consultas; 

• podem ser criados diferentes relatórios de tratamento a partir dos 

dados do dispositivo guardados no registo do doente. Os relatórios 

facilitam as respostas às preocupações com a terapia, como por 

exemplo, com a adesão do doente, os padrões e as excepções 

identificados;

• o sistema alerta-o quando existem actualizações do software para 

transferir e instalar no computador. Deste modo, tem sempre acesso 

às funções mais recentes; 

• existe ainda uma função Guide Me que ajuda os utilizadores 

inexperientes do CareLink Pro. Fornece indicações e sugestões acerca 

das tarefas que estão a realizar;

• existe um sistema de ajuda integrada no software para facultar 

informações sobre áreas de interesse específicas.

Segurança     

• O CareLink Pro pode ser protegido por uma palavra-passe.

• A transmissão de dados do doente a partir do CareLink Personal 

é encriptada pela tecnologia de referência Secure Sockets Layer (SSL).
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Documentos relacionados     

Cada um destes documentos da Medtronic MiniMed contém informações 

específicas de cada dispositivo que não são tratadas em pormenor 

neste guia do utilizador. 

NOTA: Relativamente
a medidores fabricados

por outras empresas,
consulte as instruções

do fabricante que
acompanham o medidor.

• Guia do utilizador da bomba de insulina Paradigm

• Guia do utilizador do monitor Guardian REAL-Time

• Guia do utilizador das funções do sensor 

• Guia do utilizador ComLink

• Guia do utilizador CareLink USB

Assistência

Se precisar de ajuda adicional com este sistema, contacte o seu 

representante local. Aceda ao seguinte URL para consultar os dados 

internacionais de contacto:

http://www.medtronicdiabetes.com/help/contact/locations.html

NOTA: Alguns
dispositivos suportados
por este software podem

não estar disponíveis
em todos os países em
que a utilização deste

software está
aprovada.

Dispositivos suportados

O CareLink Pro recolhe os dados dos seguintes dispositivos.           

Bombas de insulina/Monitores de glicose 

Bombas Medtronic MiniMed 508

Bombas da série Paradigm 
da Medtronic MiniMed 

511, 512, 712, 515, 715, 522, 722, 522K, 
722K, Paradigm® REAL-Time Revel™

(523, 723, 523K, 723K), Paradigm® Veo™

(554, 754)  

Monitor Guardian REAL-Time CSS-7100
CSS-7100K

Fabricante Medidor de glicose no sangue     

Dispositivos de parceiros 
da Medtronic Diabetes:

• Bayer CONTOUR® LINK

• LifeScan OneTouch® UltraLink™

• Monitor de glicose no sangue BD Paradigm Link®
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LifeScan:

• OneTouch® UltraSmart®

• OneTouch® Profile®

• OneTouch® Ultra®

• OneTouch® Basic®

• OneTouch® FastTake®

• OneTouch® SureStep®

• OneTouch® Ultra® 2

• OneTouch® UltraMini™

• OneTouch® UltraEasy®

Bayer's:

• BREEZE™

• BREEZE™ 2

• CONTOUR®

BD: • Logic®

Família Bayer's Ascensia® DEX®,
incluindo estes medidores 
compatíveis:

• Ascensia® DEX®

• Ascensia® DEX® 2 

• Ascensia® DEXTER-Z® II

• Glucometer® DEXTER-Z®

• Ascensia® ESPRIT® 2 

• Glucometer® ESPRIT®

• Glucometer® ESPRIT® 2

Família Bayer's Ascensia ELITE™,
incluindo estes medidores 
compatíveis:

• Ascensia ELITE™

• Glucometer ELITE® XL 

Abbott

• Precision Xtra™

• TheraSense FreeStyle®, FreeStyle Flash™

• FreeStyle Papillion™ Mini 
• FreeStyle Mini

• Optium Xceed™

• Precision Xceed™

Roche

• Accu-Chek® Aviva

• Accu-Chek® CompactPlus

• Accu-Chek® Compact

• Accu-Chek® Active

Dispositivos de comunicação                 

 Com-Station

para usar com a bomba MiniMed 508. 
(Consulte o Guia do utilizador Com-Station 
para mais pormenores sobre o hardware 
necessário.)

Fabricante Medidor de glicose no sangue     
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Dispositivos equivalentes

Quando adiciona um dispositivo ao sistema, deve seleccionar a respectiva 

marca e modelo numa lista. Se a marca e modelo de um dispositivo 

não se encontrarem na lista, consulte a seguinte tabela para descobrir 

um dispositivo equivalente que possa usar.

NOTA: Os medidores
podem ser encomendados

às empresas que os
fabricam.

Encomenda                       

Para encomendar produtos Medtronic Diabetes, contacte o seu 

representante local. Aceda ao seguinte URL para consultar os 

dados internacionais de contacto da Medtronic:

http://www.medtronicdiabetes.com/help/contact/locations.html

ComLink

para usar com a bomba MiniMed Paradigm 
e com o monitor Guardian REAL-Time. 
(Consulte o Guia do utilizador ComLink 
para mais pormenores sobre o hardware 
necessário.)

Monitor de glicose no sangue 
Paradigm Link®

para usar com a bomba MiniMed Paradigm 
e com o monitor Guardian REAL-Time. 
(Consulte o Guia do utilizador do monitor de 
glicose no sangue Paradigm Link® para mais 
pormenores sobre o hardware necessário.)

CareLink™ USB
para usar com a bomba MiniMed Paradigm 
e com o monitor Guardian REAL-Time.

Cabo de comunicação de dados

para usar com medidores de glicose no 
sangue de outros fabricantes. Cada fabricante 
de medidores fornece um cabo de comunicação 
de dados.

Dispositivos de comunicação                 

Se o seu doente usar um destes dispositivos Seleccione este dispositivo

• Bayer’s Ascensia® DEX®

• Bayer’s Ascensia® DEX® 2

• Bayer’s Ascensia® DEXTER-Z® II

• Bayer’s Glucometer® DEXTER-Z®

• Bayer’s Ascensia® ESPRIT® 2 

• Bayer’s Glucometer® ESPRIT®

• Bayer’s Glucometer® ESPRIT® 2

Bayer’s Ascensia® DEX®

Bayer’s Glucometer ELITE® XL Bayer’s Ascensia ELITE™ XL 

Precision Xceed™ Optium Xceed™
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Como utilizar este guia

Consulte o Glossário para obter as definições dos termos utilizados 

e das funções da bomba. Os termos e símbolos utilizados neste guia 

encontram-se na tabela seguinte.

Este guia do utilizador mostra apenas ecrãs exemplificativos do 

software. Os ecrãs reais do software podem ser ligeiramente diferentes.

Segurança do utilizador

Indicações de utilização 

O sistema CareLink Pro destina-se a ser utilizado como ferramenta 

auxiliar na gestão da diabetes. A finalidade deste sistema é transformar 

em relatórios CareLink Pro a informação recebida de bombas de insulina, 

medidores de glicose no sangue e sistema de monitorização contínua 

de glicose. Os relatórios fornecem informação que pode ser usada para 

identificar tendências e acompanhar actividades diárias — como os 

carbohidratos consumidos, as horas das refeições, a administração 

de insulina e as leituras de glicemia. 

Termo / símbolo Significado

Clicar premir o botão esquerdo do rato sobre um objecto 
no ecrã para o seleccionar 

Fazer duplo clique premir duas vezes o botão esquerdo do rato sobre um 
objecto no ecrã para o abrir

Clicar com o botão 
direito do rato

premir o botão direito do rato sobre um objecto no ecrã 
para visualizar outra janela ou menu

Texto a negrito
usado para uma opção de menu ou percurso de menu. 
Por exemplo: Patient > New Patient (Doente > Novo doente)

MAIÚSCULAS indicam um botão. Por exemplo: SAVE (Guardar)

Texto em itálico usado para nomes de ecrãs e de campos. 
Por exemplo: ecrã Reports (Relatórios)

NOTA: Informação adicional

ATENÇÃO: avisa de um perigo que, caso não seja evitado, pode 
resultar em danos ligeiros a moderados no equipamento 
ou programa de software.

AVISO: notifica-o de um possível perigo que, caso não seja 
evitado, pode resultar em morte ou ferimentos graves. 
Pode ainda descrever possíveis reacções adversas graves 
e perigos para a segurança.
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Avisos 

• Este sistema destina-se a ser usado por um médico familiarizado com 

a gestão da diabetes. 

• Os resultados do sistema não se destinam a produzir aconselhamento 

médico e não devem constituir a base do mesmo. 

• Este produto apenas deve ser usado com os dispositivos suportados 

que são enumerados neste documento. (Consulte Dispositivos

suportados, na página 3.)

• Os doentes devem ser aconselhados a monitorizar os seus níveis de 

glicemia pelo menos 4 — 6 vezes ao dia.

• Os doentes devem ser aconselhados a não alterar o tratamento sem 

consultarem o seu médico.

• Os doentes devem ser aconselhados a tomar decisões de tratamento 

com base nas orientações do médico e nos resultados do medidor de 

glicose no sangue e não nos resultados do sensor de glicose.

Contra-indicações 

Este software não deve ser usado com dispositivos que não estejam 

incluídos na lista de Dispositivos suportados, na página 3. Este produto 

não deve ser usado para tratar outros problemas médicos que não 

a diabetes.

Antes de abrir este software, encerre qualquer um dos seguintes 

programas de software que possam estar a ser executados no computador:

• Software para sistema CGMS® Solutions™

• Software para medidores e bombas Solutions®

• Software Guardian® Solutions®

• ParadigmPAL™

• CareLink™ Personal

• Software Solutions® para CGMS® iPro
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Navegar no sistema 2

Neste capítulo encontrará
• Descrição geral: página 8

• Abertura do CareLink Pro: página 8

• Espaços de trabalho: página 10

• Barra do menu principal: página 12

• Barra de ferramentas: página 12

• A função Guide Me (orientação): página 13

• Hiperligações Learn More (Saber mais): página 14

• Sistema de ajuda: página 14

Descrição geral

Use este capítulo para se familiarizar com o interface gráfico do 

utilizador do CareLink™ Pro. O interface do utilizador inclui menus, 
uma barra de ferramentas, uma barra de navegação, espaços de 
trabalho e uma janela Guide Me (orientação). 

Abertura do CareLink Pro

1 Faça duplo clique sobre o ícone do CareLink Pro presente no ambiente 
de trabalho do seu computador.

Se a sua instituição de saúde exigir que introduza uma palavra-passe, 
aparecerá um ecrã de início de sessão.

 Ícone CareLink Pro
no ambiente de

trabalho
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a. Digite a sua palavra-passe no campo Password (Palavra-passe).

NOTA: A introdução de
uma palavra-passe

é uma função opcional
configurada durante

o processo de instalação.

b. Clique em LOGIN (Iniciar sessão).

Surge o ecrã de arranque.

2 Para iniciar um novo registo de doente, clique em NEW PATIENT 

(Novo doente). Para abrir um registo de doente a partir de uma lista 

de doentes existente no sistema, clique em OPEN PATIENT (Abrir doente).

        

menus principais

espaço de 
trabalho activo

aceder à lista de doentes
adicionar um novo doente

barra de navegação

barra de estado

botão do espaço de
trabalho Reports

(Relatórios)
botão do espaço de

trabalho Devices
(Dispositivos)

botão do espaço de
trabalho Profile (Perfil)

visualizar/ocultar a janela 
Guide Me (orientação)
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Espaços de trabalho

NOTA: Consulte outros
capítulos deste guia do

utilizador para mais
pormenores sobre

os espaços de trabalho
e a forma de os utilizar.

Se tiver o registo de um doente aberto, pode clicar num dos botões da 

barra de navegação para visualizar o espaço de trabalho correspondente. 

Use estes espaços de trabalho para introduzir ou seleccionar informações 

de modo a efectuar tarefas do CareLink Pro para esse doente.

• Profile (Perfil): Permite-lhe conservar os dados do doente guardados, 

como por exemplo, o nome e a data de nascimento. Este espaço de 

trabalho permite-lhe ainda efectuar a ligação à conta CareLink Personal 

de um doente.

• Devices (Dispositivos): Permite-lhe guardar as informações necessárias 

para ler os dispositivos de um doente.

• Reports (Relatórios): Permite-lhe seleccionar parâmetros e escolher 

os relatórios a elaborar para o doente.

Até ser acrescentado e guardado o perfil de um doente, apenas o espaço 

de trabalho de Profile é acessível para esse doente. Até serem 

acrescentados os dispositivos de um doente, apenas os espaços 

de trabalho de Profile e Devices são acessíveis para esse doente.
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Espaços de trabalho     

Espaço de trabalho Devices (Dispositivos)

Espaço de trabalho Profile (Perfil)

Espaço de trabalho Reports (Relatórios)

Profile 
(Perfil)

Devices
(Dispositivos)

Reports
(Relatórios)
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Barra do menu principal

Seguem-se as opções disponíveis no menu principal. Algumas destas 

opções de menu podem igualmente ser acedidas através das teclas de 

atalho, enumeradas ao lado de cada opção do menu (por ex., Ctrl+N 

para New Patient (Novo doente)). Pode também usar a barra de navegação 

ou a barra de ferramentas para aceder a algumas opções do menu.

Barra de ferramentas

A barra de ferramentas do CareLink Pro fornece um acesso rápido às 

funções frequentemente usadas. A barra de ferramentas contém os 

seguintes botões.

Botão Nome Função

Add Patient 
(Adicionar doente)

Abre um espaço de trabalho em Profile
(Perfil) para que possa acrescentar 
o registo de um novo doente ao sistema.

Open Patient 
(Abrir doente)

Abre a tabela Patient Lookup (Localização 
de doentes) na qual pode escolher um 
registo de doente existente para visualizar.

Guide Me 
(orientação)

Mostra ou oculta a janela Guide Me (orientação). 
Clique para obter sugestões do sistema 
associadas ao contexto. 
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Separadores do doente

Ao abrir o registo de um doente, surge um separador ao longo da barra 

de ferramentas com o nome do doente. Quando o separador está activo, 

o registo do doente e o espaço de trabalho estão activos, sendo 

possível executar tarefas do CareLink Pro em relação a esse doente.

Para activar o registo de um doente, basta clicar no respectivo 

separador do doente. Para fechar o mesmo registo, clique no botão 

CLOSE (Fechar) do respectivo separador.

A função Guide Me (orientação)

A função Guide Me (orientação) está sempre presente no CareLink Pro. 
Abre uma janela com indicações e sugestões do sistema associadas ao 
contexto, sobre acções que pode realizar a partir do ponto do sistema 
que se encontra activo. As janelas Guide Me (orientação) podem incluir 
ainda hiperligações >> learn more (Saber mais). Ao clicar nestas 
hiperligações, o utilizador é levado até à secção associada da ajuda 
online, para mais pormenores. A função Guide Me (orientação) está 
normalmente activada. No entanto, é possível desactivá-la em 
qualquer altura.

Botão CLOSE 
(Fechar) 

separador inactivo separador activo

Botão CLOSE
(Fechar)
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Activar e desactivar a função Guide Me (orientação) 

Botão da opção

• Clique no botão GUIDE ME (orientação) para activar ou desactivar 

a função Guide Me.

Opção de menu

• Seleccione Help > Guide Me (Ajuda > Orientação) para seleccionar ou 

anular a selecção da função.

Hiperligações Learn More (Saber mais)

As hiperligações Learn More (Saber mais) levam-no a um tópico associado 

no sistema de ajuda online. Estas surgem ao longo do sistema, dentro 

de janelas Guide Me ou do software. Clique em >> learn more (saber 

mais) se não tiver a certeza de como prosseguir ou dos valores que deve 

introduzir.

Sistema de ajuda

O sistema de ajuda está disponível para o ajudar durante a utilização 

do CareLink Pro. Fornece informações sobre como realizar tarefas no 

software. 

Para aceder ao sistema de ajuda, proceda da seguinte forma:

• seleccione Help > Medtronic CareLink Pro Help
(Ajuda > Ajuda do Medtronic CareLink Pro). 

• prima o botão F1.

Botão Guide Me
(orientação)

hiperligação Learn More (Saber mais)    
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Preparação 3

Neste capítulo encontrará
• Antes de começar: página 15

• Abrir e fechar registos de doentes: página 17

• Configurar as preferências do sistema: página 18 

Este capítulo orienta-o ao longo do processo de iniciar o software 

CareLink™ Pro, abrir e fechar os registos dos doentes e configurar 

as preferências a aplicar a todos os doentes do sistema. 

Antes de começar

Se for a primeira vez que está a usar o CareLink Pro, assegure-se de 

que configura as preferências gerais (consulte Preferências gerais, na 

página 18). Estas preferências determinam a forma como certos itens 

são visualizados no software e nos relatórios, e como o sistema vai 

comunicar com a Internet.

As preferências podem ser configuradas em qualquer altura. É aconselhável 

aguardar até que esteja familiarizado com o software CareLink Pro 

antes de configurar as outras preferências.
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Principais tarefas do sistema

A tabela seguinte contém as principais tarefas que deve executar da 

primeira vez que configurar e utilizar o CareLink Pro. Indica-lhe ainda 

a parte deste guia do utilizador na qual se aborda cada uma das tarefas.

Etapa Localização

Familiarizar-se com a interface do 
utilizador do CareLink Pro. Capítulo 2, Navegar no sistema

Definir as opções globais do sistema 
que a sua instituição de saúde utiliza.

Configurar as preferências do sistema, 
na página 18

Criar perfis para cada um dos doentes. Adicionar novos perfis, na página 25

Efectuar a ligação às contas do 
CareLink Personal dos seus doentes.

Efectuar uma ligação ao CareLink 
Personal (opcional), na página 26

Adicionar a bomba e medidores dos 
doentes ao respectivo perfil. Adicionar um dispositivo, na página 35

Ler os dados da bomba e medidores dos 
doentes. Ler dados do dispositivo, na página 41

Configurar e elaborar relatórios para 
cada um dos doentes.

Criação de relatórios, na página 45

Efectuar regularmente cópias de 
segurança da base de dados do 
CareLink Pro.

Efectuar cópias de segurança de uma 
base de dados, na página 58

Actualizar o software CareLink Pro.
Instalação de actualizações do 
software, na página 57
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Abrir e fechar registos de doentes

Abrir registos de doentes         

É possível abrir um máximo de seis registos de doentes em simultâneo. 
Se ainda não tiver criado quaisquer perfis de doentes, consulte 
Adicionar novos perfis, na página 25.

1 Seleccione File > Open Patient (Ficheiro > Abrir doente) ou clique 
no botão OPEN PATIENT (Abrir doente). É visualizada uma lista de 
doentes semelhante à seguinte.

NOTA: Se receber uma
mensagem indicando

que estão abertos
demasiados registos de
doentes, clique em OK,

feche um registo
e continue.

2 Localize a lista de doentes digitando parcial ou integralmente o seu 
nome no campo Find a Patient (Localizar um doente). Quando a lista 
de doentes aparecer realçada, clique em OPEN (Abrir), faça duplo 
clique sobre a lista ou prima ENTER. Pode ainda navegar na lista, 
usando as setas ascendente e descendente do teclado. 

Surge o espaço de trabalho Devices (Dispositivos) (se os dispositivos 
ainda não tiverem sido acrescentados) ou Reports (Relatórios) do doente.

3 Para ver o espaço de trabalho Profile (Perfil) do doente, clique no 
botão PROFILE na barra de navegação.

Fechar registos de doentes        

1 Assegure-se de que o registo do doente que pretende fechar está 
activo (separador realçado).

2 Efectue uma das seguintes acções:

a. seleccione File > Close Patient (Ficheiro > Fechar doente);

b. clique no botão CLOSE (Fechar) do separador do doente;

c. prima Ctrl+F4.

Open Patient
(Abrir doente)

botão

Botão Profile (Perfil)

botão CLOSE (Fechar)
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Configurar as preferências do sistema

Estas preferências aplicam-se a todos os doentes do sistema. Para saber 
mais sobre as preferências que se aplicam apenas a doentes individuais, 
consulte Verificação das configurações dos relatórios, na página 49.

As preferências apresentam-se divididas pelos seguintes grupos:

• General (Gerais)

– Glucose units (Unidades de glicemia)

– Carbohydrate units (Unidades de carbohidratos)

– Communications (Comunicações)

– Troubleshooting (Resolução de problemas)
• Patient Profile (Perfil do doente)

– Seleccione e disponha os campos de dados nos perfis dos doentes.
• Patient Lookup (Localização de doentes)

– Modifique e altere a ordem dos campos visualizados quando 
selecciona Open Patient (Abrir doentes) para ver uma lista de 
doentes.

• Report Generation (Criação de relatórios)

– Escolha os campos de dados que pretende visualizar ao seleccionar 
na Data Table (Tabela de dados) os elementos que devem figurar 
no relatório Daily Detail (Diário exaustivo).

Preferências gerais  

1 Seleccione Tools > Options (Ferramentas > Opções). Surge a janela 
seguinte.
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2 Clique para seleccionar o botão de opção relativo ao valor que pretende:

– Glucose Units (Unidades de glicemia): mg/dL ou mmol/L

– Carbohydrate Units (Unidades de carbohidratos): grams ou 
Exchanges (gramas ou porções)

a. Se tiver seleccionado Exchanges (Porções) como as Carbohydrate 
Units (Unidades de carbohidratos), digite o número adequado no 
campo grams are equal to 1 Exchange (gramas equivalem a 1 porção).

3 Em Communications (Comunicações) que surge a seguir, clique para 

seleccionar a caixa de verificação (activar) ou para limpar a caixa de 

verificação (desactivar):

NOTA: Assegure-se de
que respeita as

directrizes da sua
instituição de saúde ou
departamento de TI ao

configurar as
preferências de

comunicação.

– Automatically check for software updates (Verificar 
automaticamente a existência de actualizações do software):
se for seleccionada, será enviada uma notificação a cada sistema 
que estiver a executar o CareLink Pro, sempre que ficar disponível 
uma actualização do software. O utilizador activo terá então 
a oportunidade de transferir e instalar as actualizações. Para evitar 
que tal aconteça e para instituir uma distribuição controlada das 

actualizações do software, pode limpar esta caixa de verificação.

– Synchronize with CareLink™ Personal (Sincronizar com 

CareLink™ Personal): se pretender que o sistema efectue 
automaticamente a sincronização com os dados do CareLink 
Personal do doente, de cada vez que abrir o respectivo perfil, 
seleccione a caixa de verificação Synchronize with CareLink 
Personal (Sincronizar com o CareLink Personal). Se limpar esta 
caixa de verificação, terá de sincronizar manualmente os dados 
do CareLink Personal de cada doente.

4 Clique para seleccionar ou limpar a caixa de verificação na secção 

Troubleshooting (Resolução de problemas). Se a caixa de verificação 

for seleccionada, a aplicação guardará um registo das leituras do 

dispositivo para a resolução de problemas.

5 Clique em OK para guardar as preferências gerais. 
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Preferências do perfil do doente         

1 Seleccione Tools > Options (Ferramentas > Opções). 

2 Clique no separador Patient Profile (Perfil do doente). Surge a janela 

seguinte.

Escolher campos de dados  

1 Use as caixas de verificação para adicionar os campos que pretende.

NOTA: Os campos de
First e Last Name (Nome

e apelido) não podem
ser removidos.

2 Para retirar um campo de um perfil, limpe a respectiva caixa de 

verificação.

3 Para fazer com que um campo seja de preenchimento obrigatório, 
seleccione a caixa de verificação da coluna Required (Obrigatório). 
Este tipo de campo tem obrigatoriamente de ser preenchido para 
que possa ser criado um perfil.

Adicionar um campo personalizado         

1 Seleccione a caixa de verificação à esquerda de um campo 
personalizado vazio.

2 Digite o texto para atribuir um nome ao campo (por ex., Emergency 
Contact (Contacto de emergência)). Este é o nome de campo que 
aparecerá no perfil do doente.

3 Para fazer com que o campo seja de preenchimento obrigatório, 
seleccione a caixa de verificação da coluna Required (Obrigatório).

Use as caixas de verificação para escolher os campos que pretende ter no perfil. Use 
os botões com setas ascendente e descendente para colocar os campos em ordem.
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NOTA: Para retirar um
campo personalizado do
perfil, limpe a caixa de
verificação ao lado do(s)
campo(s) que pretende

remover.

Alterar a ordem dos campos de dados        

• Seleccione o campo que pretende deslocar e clique na seta ascendente 

ou descendente para o deslocar. (As setas nas partes superior ou 

inferior deslocam o campo para o topo ou para o fundo da lista.) 

Finalizar as preferências do perfil do doente        

• Quando a lista Field Order (Ordem dos campos) tiver todos os campos 

pretendidos na ordem correcta, clique em OK.

Os perfis dos doentes apresentam agora os campos e a ordem dos campos 

que acabou de seleccionar.

Preferências de Patient Lookup (Localização de doentes)         

1 Seleccione Tools > Options (Ferramentas > Opções). 

2 Clique no separador Patient Lookup (Localização de doentes). 

Surge a janela seguinte.

Escolher dados para visualizar  

• Use as caixas de verificação para seleccionar o tipo de dados que 

pretende visualizar ou para apagar os dados que não pretende 

visualizar na tabela Patient Lookup (Localização de doentes).

Botão com seta
 ascendente/descendente

Use as caixas de verificação para escolher os dados que pretende ter na tabela 
Patient Lookup (Localização de doentes). Use os botões com setas ascendente 
e descendente para colocar as colunas em ordem.
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NOTA: Os campos de
First e Last Name (Nome

e apelido) não podem
ser removidos.

Alterar a ordem das colunas  

• Para alterar a ordem das colunas na tabela Patient Lookup 

(Localização de doentes), seleccione a coluna a deslocar e clique nas 

setas ascendente ou descendente. (As setas nas partes superior ou 

inferior deslocam uma coluna de dados para o topo ou para o fundo 

da lista.)

NOTA: A coluna de
dados no topo da lista
Column Display Order

(Ordem de visualização
das colunas) aparecerá
na primeira coluna da
tabela Patient Lookup

(Localização de doentes).
A coluna de dados ao

fundo será visualizada
na última coluna da

tabela.

Finalização das preferências de Patient Lookup (Localização de doentes)         

• Quando a lista Column Display Order (Ordem de visualização das colunas) 

tiver todos os dados pretendidos na ordem correcta, clique em OK.

A tabela Patient Lookup (Localização de doentes) apresenta agora 

todos os dados e colunas na ordem que acabou de seleccionar.

Preferências para a criação de relatórios  

A Data Table (Tabela de dados) é visualizada durante a fase de selecção 

do processo de criação do relatório. Esta tabela deve incluir os dados 

que o médico considerar mais úteis para decidir as datas em relação 

às quais pretende ver relatórios do tipo Daily Detail (Diário exaustivo).

NOTA: Para ver como
estas preferências se
aplicam à Data Table

(Tabela de dados) durante
a criação de um relatório,

consulte Selecção de
tipos de relatórios e

datas de inclusão,
na página 51.

1 Seleccione Tools > Options (Ferramentas > Opções). 

2 Clique no separador Report Generation (Criação de relatórios). 

Surge a janela seguinte.

Botão com seta
 ascendente/descendente

Use as caixas de verificação para escolher o tipo de dados que pretende ter na Data 
Table (Tabela de dados). Use os botões com setas ascendente e descendente para 
colocar as colunas em ordem.
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Escolher dados para visualizar        

• Use as caixas de verificação para seleccionar o tipo de dados que 

pretende visualizar ou para apagar os dados que não pretende visualizar 

na Data Table (Tabela de dados).

Alterar a ordem das colunas       

• Para alterar a ordem das colunas na Data Table (Tabela de dados), 

seleccione a coluna a deslocar e clique nas setas ascendente ou 

descendente. (As setas nas partes superior ou inferior deslocam 

uma coluna de dados para o topo ou para o fundo da lista.)

NOTA: Os itens no topo
da lista Column Order

(Ordem das colunas)
aparecerão na primeira

coluna da Data Table
(Tabela de dados). Os

itens ao fundo serão
visualizados na última
coluna da Data Table

(Tabela de dados).

Finalização das preferências para a criação de relatórios         

• Quando a lista Column Order (Ordem das colunas) tiver todos os dados 

pretendidos na ordem correcta, clique em OK. 

A Data Table (Tabela de dados) apresenta agora todos os dados 

e colunas na ordem que acabou de seleccionar.

Botão com seta
 ascendente/descendente
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Espaço de trabalho Profile 
(Perfil) 4

Neste capítulo encontrará
• Antes de começar: página 24

• Adicionar novos perfis: página 25

• Editar perfis de doentes: página 25

• Eliminar os dados do doente do sistema: página 25

• Efectuar uma ligação ao CareLink Personal (opcional): página 26

Um perfil é semelhante à capa de um processo de doente. Guarda os 

dados do doente, como o nome e a data de nascimento. É necessário 

existir um perfil para que possam ser reunidos e usados dados sobre 

o dispositivo nos relatórios da terapia.

O espaço de trabalho Profile (Perfil) permite-lhe ainda configurar 

uma ligação à conta CareLink Personal do doente. Estabelecida uma 

ligação, é possível recuperar em qualquer altura os dados do doente 

guardados no CareLink Personal — sem que o doente esteja presente.

Antes de começar

Pode personalizar os perfis dos doentes de modo a que contenham 

apenas o tipo de informação que pretende recolher. Para mais 

informações, consulte Preferências do perfil do doente, na página 20.

É necessário um nome de utilizador e uma palavra-passe para configurar 

a ligação à conta CareLink Personal do doente. O doente tem de estar 

presente para facultar estes dados.
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Adicionar novos perfis

De cada vez que adicionar um doente ao sistema CareLink Pro, tem de 

começar por preencher um perfil para esse doente. 

1 Seleccione File > New Patient (Ficheiro > Novo doente) ou clique 

no botão ADD PATIENT (Adicionar doente). 

Surge o espaço de trabalho Profile (Perfil) (ver exemplo na página 11). 

NOTA: Para adicionar
ou alterar os campos do
perfil do doente, clique

em >> customize fields
(personalizar campos).

Consulte Preferências do
perfil do doente,

na página 20.

2 Preencha os campos da secção Patient Profile (Perfil do doente). 

3 Clique em SAVE (Guardar).

O novo perfil de doente é adicionado à base de dados do CareLink Pro. 
Surge uma mensagem que confirma que o perfil foi guardado.

Se um campo de preenchimento obrigatório não estiver completado 
ao guardar o perfil de um doente, surge uma mensagem ao lado desse 
campo. Não poderá guardar esse perfil até ter digitado algo no campo 
em questão.

Editar perfis de doentes

1 Verifique se o espaço de trabalho do Profile (Perfil) do doente está 
aberto.

2 Clique em EDIT (Editar).

3 Edite os dados da secção Patient Profile (Perfil do doente), conforme 
necessário.

4 Clique em SAVE (Guardar).

Surge uma mensagem que confirma que o perfil foi guardado.

Eliminar os dados do doente do sistema

1 Verifique se o espaço de trabalho do Profile (Perfil) do doente está 
aberto. 

2 Verifique se este é o doente que pretende eliminar. Se eliminar 
o perfil do doente estará também a eliminar todos os dados do 
mesmo doente da base de dados do CareLink Pro, não podendo 
restaurá-los mais tarde.

3 Clique em >> delete patient record (eliminar registo de doente) 
acima da secção de sincronização do perfil.

Surge uma mensagem para o alertar de que todos os dados do doente 
serão apagados quando eliminar o registo. 

4 Clique em YES (Sim) para eliminar o registo do doente.

Add Patient
(Adicionar doente)

botão
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Efectuar uma ligação ao CareLink Personal 
(opcional)

Se o doente o autorizar, é possível estabelecer uma ligação à conta 

do CareLink Personal. Esta ferramenta com base na Web permite aos 

doentes enviar e guardar dados recolhidos pelo dispositivo e elaborar 

vários relatórios de terapia. 

Depois de ligar à conta CareLink Personal do doente, pode recuperar 

os dados do dispositivo aí guardados para serem utilizados ao gerar 

relatórios do CareLink Pro. Os relatórios podem ser gerados em qualquer 

altura, mesmo entre consultas. Reduz ainda a necessidade de ler 

o dispositivo do doente no consultório.

Se um doente ainda não tiver uma conta CareLink Personal, pode enviar-

lhe uma mensagem de correio electrónico convidando-o a criar uma conta. 

Efectuar uma ligação a uma conta já existente  

NOTA: O doente tem de
estar presente para

executar estas etapas.

1 Assegure-se de que não está ligado à Internet.

2 Abra o espaço de trabalho do Profile (Perfil) do doente. 

3 Verifique se os campos de preenchimento obrigatório na secção 

Patient Profile (Perfil do doente) estão preenchidos.

4 Clique em LINK TO EXISTING ACCOUNT (Efectuar uma ligação a uma 

conta já existente). 

É visualizado o ecrã de Login (Início de sessão) do CareLink Personal.

5 Peça ao doente para:

a. digitar o seu nome de utilizador e palavra-passe; ou

b. clicar em SIGN IN (Inscrição). 
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Surge uma página Grant of Access (Concessão de acesso), com base 

nas definições de idioma e região da inscrição do doente.

6 Peça ao doente para:

a. ler os Terms of Use (Termos de utilização);

b. clicar na caixa de verificação ao lado de I agree to the Terms of 
Use above... (Concordo com os termos de utilização anteriores); 

c. clicar em GRANT ACCESS (Conceder acesso);

d. informá-lo quando surgir a página Thank You (Obrigado).
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Pode imprimir os Terms of Use (Termos de utilização) para o doente, 

clicando no botão PRINT (Imprimir).

Está agora ligado à conta CareLink Personal deste doente. Consulte 

Obter dados a partir da ligação a uma conta, na página 29.

Enviar um convite por correio electrónico 

Para enviar uma mensagem de correio electrónico convidando um 

doente a criar uma conta no CareLink Personal, siga estas etapas:

1 Abra o espaço de trabalho do Profile (Perfil) do doente. 

2 Verifique se os campos de preenchimento obrigatório na secção 

Patient Profile (Perfil do doente) estão preenchidos.

3 Clique em SEND E-MAIL INVITATION TO PATIENT (Enviar uma mensagem 

de correio electrónico a um doente).

4 Verifique se os campos de Patient Name (Nome do doente), Email

(Correio electrónico) e Language... (Idioma) estão correctamente 

preenchidos.

5 Clique em SEND (Enviar). 

A área de estado do perfil do doente confirma que a mensagem 

de correio electrónico foi enviada.
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Anular a ligação à conta CareLink Personal de um doente a partir 
do CareLink Pro

É possível anular a ligação à conta CareLink Personal de um doente 

a partir do CareLink Pro. Esta opção apenas está disponível depois 

de ter sido efectuada uma ligação para um doente. Impede que 

o CareLink Pro continue a recuperar dados da conta CareLink Personal 

do doente. Não afecta a utilização pessoa do doente da sua conta 

CareLink Personal.

1 Abra o registo do doente e aceda ao espaço de trabalho de Profile (Perfil).

2 Clique em UNLINK ACCOUNT (Anular ligação à conta).

3 Clique em Yes (Sim) na mensagem de confirmação. O perfil pessoal 

do doente deixa de estar ligado ao CareLink Pro.

O estado passa a “Not linked” (Não ligado) e os botões LINK TO EXISTING 

ACCOUNT (Ligar a uma conta existente) e SEND E-MAIL INVITATION TO 

PATIENT (Enviar convite por mensagem de correio electrónico a doente) 

não são visualizados.

Obter dados a partir da ligação a uma conta

Se estiver ligado à conta CareLink Personal de um doente, quaisquer 

novos dados provenientes desta conta são automaticamente enviados 

sempre que abrir o respectivo perfil de doente no CareLink Pro. 

NOTA: Para assegurar
que isto acontece, vá
até Tools > Options >

General (Ferramentas >
Opções > Geral)

e verifique se assinalou
a caixa ao lado de
“Synchronize with

Medtronic CareLink
Personal” (Sincronizar

com Medtronic CareLink
Personal).

Siga estas etapas para obter os dados do CareLink Personal do doente 

sempre que abrir o respectivo perfil de doente:

1 Certifique-se que o espaço de trabalho do Profile (Perfil) do doente 

está aberto e que o computador se encontra ligado à Internet.

2 Seleccione Tools > Synchronize Patient Data (Ferramentas > 

Sincronizar dados do doente).

O ícone de sincronização no separador do doente gira. Quando 

o ícone pára, o processo está completo.

NOTA: Se o doente
não quiser continuar

a partilhar os
respectivos dados de

CareLink Personal, pode
desactivar esta função

no menu OPTIONS
(Opções). É apresentada

uma mensagem com
esta indicação.

3 Quaisquer dados adicionais recuperados do CareLink Personal 

aparecerão nos relatórios do doente. 

ícone de sincronização
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Configuração do hardware 5

Neste capítulo encontrará
• Antes de começar: página 30

• Ligação de dispositivos: página 31

Este capítulo contém diagramas que mostram como configurar o dispositivo 

do doente, de modo a que o computador possa efectuar a leitura de 

dados a partir do mesmo.

É necessário ter o dispositivo do doente para poder efectuar a leitura 

de dados directamente a partir deste. No entanto, é possível obter 

dados do dispositivo a partir da conta CareLink™ Personal do doente, 

sem efectuar a leitura do dispositivo.   

Antes de começar

Para ler dados directamente a partir de um dispositivo, deverá ter 

o dispositivo do paciente e quaisquer cabos ou dispositivos de comunicação 

necessários para transferir os dados para o seu computador.
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Ligação de dispositivos

NOTA: Para mais
pormenores, siga as

instruções do CareLink™

Pro durante a leitura
dos dispositivos.

Reveja o diagrama geral para ficar com uma ideia geral de como deve 

configurar os dispositivos para que estes comuniquem com o computador. 

Os diagramas que se seguem ilustram aspectos específicos da comunicação 

entre dispositivos. 

NOTA: Este exemplo
mostra o CareLink USB

a ser utilizado para
comunicar entre

a bomba de insulina
e o computador.

Descrição geral da configuração do hardware               

TM

CareLinkUSB

CareLink USB

PC

Bomba de insulina 
Paradigm
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Diagramas das ligações do hardware                                    

                      

Ligações ao PC

Porta
USB

Porta
série
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ligar à porta
série do PC

ComLink para utilizar com a bomba de insulina da série Paradigm

Componentes opcionais

Com-Station para utilizar com as bombas de insulina MiniMed 508 
e para passagem do medidor
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Espaço de trabalho Devices 
(Dispositivos) 6

Neste capítulo encontrará
• Antes de começar: página 35

• Adicionar um dispositivo: página 35

• Activar ou inactivar um dispositivo: página 40 

• Ler dados do dispositivo: página 41

Os dados necessários para ler o dispositivo de um doente (marca, 

modelo, número de série, etc.) são guardados no espaço de trabalho 

Devices (Dispositivos). Assim, não é necessário indicá-los sempre que 

efectuar uma leitura de dados no dispositivo. 

Os dispositivos presentes no espaço de trabalho Devices encontram-se 

guardados numa de duas listas — Active Devices (Dispositivos activos) 

ou Inactive Devices (Dispositivos inactivos). Quando adiciona um 

dispositivo, este é automaticamente colocado na lista Active Devices

(Dispositivos activos). Apenas pode ler dados em dispositivos incluídos 

na lista Active Devices. Estes são os dispositivos mais provavelmente 

usados nessa altura pelo doente. 

Outros dispositivos que pertençam ao doente mas que não estejam 

a ser utilizados nesse momento, podem ser guardados na lista Inactive

Devices (Dispositivos inactivos). Esta acção mantém a informação no 

ficheiro. Estes dispositivos podem ser activados em qualquer altura.
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Antes de começar

Antes de abrir o espaço de trabalho Devices (Dispositivos) de um 
doente, este último tem de ter um perfil guardado no sistema. 
Consulte o Capítulo 4, Espaço de trabalho Profile (Perfil).

Para adicionar um dispositivo ou efectuar uma leitura directa de dados, 
o dispositivo tem de estar em comunicação com o computador. 
Consulte o Capítulo 5, Configuração do hardware para saber como 
pode configurar os dispositivos de modo a que estes comuniquem com 
o computador.

Adicionar um dispositivo

É possível obter dados da conta CareLink Personal do doente, relativos 

a um dispositivo que ainda não tenha sido adicionado. Estes dispositivos 

serão automaticamente adicionados durante a sincronização de dados 

entre o CareLink Personal e o CareLink Pro.

NOTA: Apenas pode
existir uma bomba de

insulina activa por
doente. Se adicionar
uma nova bomba de

insulina, a bomba
existente passará para
a lista de dispositivos

inactivos.

Adicionar uma bomba de insulina Medtronic ou monitor Guardian          

1 Assegure-se de que o dispositivo que está a adicionar foi configurado 
para comunicar com o computador. (Consulte as etapas de ligação no 
Capítulo 5, Configuração do hardware.)

2 Clique no separador do doente ou faça duplo clique no respectivo 
nome na tabela Patient Lookup (Localização de doentes).

3 Clique em DEVICES (Dispositivos) para aceder ao espaço de trabalho 
Devices do doente (consulte o exemplo na página 11).

4 Clique em ADD DEVICE (Adicionar dispositivo).

5 Seleccione Medtronic Pump/Guardian (Bomba de insulina 
Medtronic/Guardian). Surge o Assistente Add Medtronic 
Pump/Guardian (Adicionar bomba de insulina Medtronic/Guardian).

Botão DEVICES
(Dispositivos)
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NOTA: O modelo da
bomba de insulina

encontra-se inscrito na
parte posterior da

bomba ou no ecrã de
estado da bomba.

6 Seleccione o botão de opções para especificar o dispositivo que vai 
adicionar. 

Se tiver seleccionado a opção MiniMed 508 pump (bomba de insulina 
MiniMed 508), passe à etapa 9.

7 Clique em NEXT (Seguinte). Aparece a página Serial Number
(Número de série).

NOTA: Aparecerá uma
mensagem de erro se

não introduzir o número
de série correcto.

Verifique os exemplos
desta página e confirme

se está a introduzir os
caracteres correctos,

inscritos na parte
posterior da bomba de

insulina. Se necessário,
digite de novo os seis

caracteres.

8 Use os exemplos desta página para localizar o número de série com 
seis caracteres no dispositivo que vai ser adicionado. (Se precisar de 
mais ajuda para o localizar, clique em >> learn more (Saber mais)) 
Digite os seis caracteres no campo Device Serial Number (Número
de série do dispositivo).

9 Clique em NEXT (Seguinte). É visualizada uma página Communication
Options (Opções de comunicação) semelhante à seguinte.

10 Clique no menu pendente Choose Port (Escolher porta) e seleccione 

a porta do seu computador à qual vai ser ligado o ComLink, 

o Paradigm Link®, o CareLink USB ou o Com-Station. Se não tiver 

a certeza da porta a escolher, seleccione Auto Detect (or USB)
(Detecção automática (ou USB)). 



Guia do utilizador CareLink™ Pro    Espaço de trabalho Devices (Dispositivos)      37

11 Clique em NEXT (Seguinte). É visualizada a página Test Connection

(Testar ligação) semelhante à seguinte.

12 Siga todas as instruções do dispositivo e clique em TEST (Testar).

Surge uma mensagem informando-o de que a ligação teve êxito. 

Se isso acontecer, passe à etapa seguinte. 

NOTA: Este teste não
efectua uma leitura dos

dados da bomba de
insulina, mas verifica

a boa comunicação
entre a bomba

e o computador.

Se isso não acontecer, verifique se o hardware de ligação entre 

o dispositivo e computador está correctamente ligado. Além disso, 

pode clicar em BACK (Retroceder) nas páginas no Assistente para 

verificar se os dados do dispositivo que introduziu estão correctos.

13 Clique em DONE (Pronto).

A bomba de insulina é adicionada à lista de Active Devices

(Dispositivos activos) do doente.
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Adicionar um medidor

1 Clique no separador do doente ou faça duplo clique no respectivo 

nome na tabela Patient Lookup (Localização de doentes).

2 Assegure-se de que o medidor que está a adicionar está em 

comunicação com o computador. (Consulte as etapas de ligação 

no Capítulo 5, Configuração do hardware.)

3 Clique em DEVICES (Dispositivos) para aceder ao espaço de trabalho 

Devices do doente (consulte o exemplo na página 11).

4 Clique no botão ADD DEVICE (Adicionar dispositivo).

5 Seleccione Blood Glucose Meter (Medidor de glicose no sangue). 

Surge o Assistente Add Blood Glucose Meter (Adicionar medidor 

de glicose no sangue).

6 Clique no obtão de opções para seleccionar a marca correcta do medidor.

7 Clique em NEXT (Seguinte). Aparece a página Meter Model (Modelo 

do medidor) (esta página difere dependendo do fabricante do medidor).
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8 Clique para seleccionar o modelo de medidor que vai adicionar. 

9 Clique em NEXT (Seguinte). Aparece a página Communication

Options (Opções de comunicação).

NOTA: Apenas as opções
que forem válidas para

o medidor que está
a adicionar ficam
disponíveis para

selecção.

10 Clique no menu pendente Choose Port (Escolher porta) e seleccione 

a porta do seu computador à qual vai ser ligado o ComLink, 

o Paradigm Link® ou o CareLink USB. Se não tiver a certeza da 

porta a escolher, seleccione Auto Detect (Detecção automática). 

11 Clique em NEXT (Seguinte). Aparece a página Test Connection

(Testar ligação).

12 Siga todas as instruções relativas ao dispositivo e clique em TEST (Testar).

Surge uma mensagem informando-o de que a ligação teve êxito. 

Se isso acontecer, passe à etapa seguinte. 

Se isso não acontecer, verifique se o hardware de ligação entre 

o dispositivo e computador está correctamente ligado. Além disso, 

pode clicar em BACK (Retroceder) no Assistente para verificar se 

os dados que introduziu estão correctos.
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13 Clique em DONE (Pronto).

O medidor é adicionado à lista de Active Devices (Dispositivos activos) 

do doente.

Activar ou inactivar um dispositivo

Os dispositivos podem ser deslocados entre a lista Active Devices

(Dispositivos activos) e a lista Inactive Devices (Dispositivos inactivos), 

conforme necessário. Um dispositivo tem de estar activo para que 

a leitura de dados no mesmo seja possível. 

Pode ter todos os medidores que quiser na lista Active Devices (Dispositivos 

activos) mas apenas uma bomba de insulina. Verifique se pretende 

inactivar a bomba que está activa antes de adicionar uma nova.

Inactivar um dispositivo              

1 Clique no separador do doente ou faça duplo clique no respectivo 

nome na tabela Patient Lookup (Localização de doentes).

2 Clique em DEVICES (Dispositivos) para aceder ao espaço de trabalho 

Devices do doente.

NOTA: Os dispositivos
podem aparecer na lista

com o nome de um
dispositivo equivalente.

Consulte Dispositivos
equivalentes, na

página 5.

3 Clique em >> make this device inactive (Inactivar este dispositivo) 

sob o dispositivo que pretende inactivar.

O dispositivo desloca-se para a lista Inactive Devices (Dispositivos 

inactivos).

Reactivar um dispositivo               

1 Clique no separador do doente ou faça duplo clique no respectivo 

nome na tabela Patient Lookup (Localização de doentes).

2 Clique em DEVICES (Dispositivos). Aparece o espaço de trabalho 

Devices (Dispositivos) do doente.

3 Clique em >> activate this device (Activar este dispositivo) sob 

o dispositivo que pretende activar.

O dispositivo desloca-se para a lista Active Devices (Dispositivos activos).
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Eliminar um dispositivo             

Estas etapas eliminarão um dispositivo e respectivos dados do espaço 

de trabalho Devices (Dispositivos) e do sistema CareLink Pro:

1 Clique no separador do doente ou faça duplo clique no respectivo 

nome na tabela Patient Lookup (Localização de doentes).

2 Clique em DEVICES (Dispositivos) para aceder ao espaço de trabalho 

Devices do doente.

3 Verifique se o dispositivo se encontra na lista Inactive Devices

(Dispositivos inactivos). Se não estiver, clique em >> Inactivate this 
device (Inactivar este dispositivo) sob a respectiva referência na lista.

4 Clique em >> delete this device (Eliminar este dispositivo) sob 

o dispositivo que pretende eliminar.

Surge uma mensagem para o alertar de que o dispositivo e todos 

os seus dados serão apagados do registo do doente.

5 Clique em YES (Sim) para eliminar o dispositivo. 

O dispositivo e respectivos dados são removidos do espaço de trabalho 

Devices (Dispositivos) e do sistema CareLink Pro. Os dados deste 

dispositivo deixam de estar disponíveis para inclusão nos relatórios.

Ler dados do dispositivo

Uma das formas de obter dados do dispositivo é efectuar uma ligação 

à conta CareLink Personal do doente. (Consulte Efectuar uma ligação 

ao CareLink Personal (opcional), na página 26.) Outras das formas 

é efectuar a leitura directamente a partir do dispositivo do doente, 

tal como se descreve neste capítulo. 

Os dados do dispositivo do doente podem ser lidos pelo CareLink Pro 

se o dispositivo estiver incluído na lista Active Devices (Dispositivos 

activos) e estiver em comunicação com o computador. Tendo obtido 

estes dados, pode usá-los para elaborar relatórios que o ajudarão 

a avaliar a gestão da terapia do doente. (Consulte o Capítulo 7, Espaço de 

trabalho Reports (Relatórios) para obter mais informações sobre os 

relatórios.)
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Apresentam-se a seguir alguns tipos de informação que o sistema 
CareLink Pro recolhe a partir de uma bomba de insulina durante um 
envio:

• várias configurações da bomba, como o modo de alerta, o volume 
do sinal sonoro e o formato horário

• quantidades de insulina basal administradas
• eventos de bolus e quantidades administradas
• entradas da Ajuda de Bolus
• quantidades de enchimento
• períodos de suspensão
• leituras do sensor de glicose ao longo de um período de tempo em 

bombas com capacidades de sensor

O sistema também pode recolher dados de um sistema Guardian 
REAL-Time, incluindo:

• leituras do sensor de glicose (SG)
• valores de coeficiente do sensor
• factores de calibragem do sensor
• marcadores de refeição
• injecções de insulina

Adicionalmente, podem ser enviadas várias informações armazenadas 

num medidor de glicose no sangue para o sistema durante uma leitura 

de dispositivo. 

AVISO: Cancele ou termine todos os bolus activos e índices basais temporários e limpe 
todos os alarmes activos. O funcionamento da bomba de insulina será suspenso durante 
a leitura. Completada a leitura, verifique se a bomba retomou o funcionamento.

ATENÇÃO: Não use o controlo remoto da bomba de insulina durante a leitura da mesma. 

Se a pilha da bomba de insulina estiver fraca, a bomba não enviará dados para o PC. 
Substitua a pilha se o estado indicar que a energia da pilha está fraca.    

1 Clique no separador do doente ou faça duplo clique no respectivo 

nome na tabela Patient Lookup (Localização de doentes).

2 Assegure-se de que o dispositivo do doente está em comunicação com 

o computador. (Consulte o Capítulo 5, Configuração do hardware.)

3 Clique em DEVICES (Dispositivos) para aceder ao espaço de trabalho 

Devices do doente.

NOTA: Os dispositivos
podem aparecer na lista

com o nome de um
dispositivo equivalente.

Consulte Dispositivos
equivalentes, na

página 5.

4 Localize o dispositivo do qual pretende extrair os dados na lista 
Active Devices (Dispositivos activos) e verifique se os dados de 
Choose port (Escolher porta) estão correctos.

– No caso das bombas de insulina, clique no menu pendente 
Amount of Data (Quantidade de dados) e seleccione a quantidade 
de dados da bomba que pretende que o CareLink Pro leia.
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5 Clique no respectivo botão READ DEVICE (Ler dispositivo).

6 Siga as instruções específicas do dispositivo e clique em OK.

7 O CareLink Pro apresenta uma barra de progresso que vai sendo 

actualizada, de modo a mostrar a porção da leitura do dispositivo 

que já foi completada.

8 Se clicar em CANCEL (Cancelar) durante a leitura do dispositivo, 

surge uma mensagem que o alerta para o facto de um cancelamento 

da acção poder resultar na perda de todos os dados lidos até ao momento. 

Será necessário clicar no botão READ DEVICE (Ler dispositivo) (etapa 5)

para reiniciar o envio.

– Para cancelar, clique em YES (Sim). 

– Para continuar a ler os dados do dispositivo, clique em NO (Não).

Quando o sistema termina a leitura de dados do dispositivo, verá 

uma mensagem confirmando que a leitura do dispositivo está completa.

9 Clique em OK. 

– No caso das bombas de insulina, siga as instruções para as retirar 
do modo de suspensão.

Se o CareLink Pro não conseguir recolher os dados do dispositivo, consulte 

o Capítulo 9, Resolução de problemas para obter mais orientações.
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Espaço de trabalho Reports 
(Relatórios) 7

Neste capítulo encontrará
• Antes de começar: página 44

• Criação de relatórios: página 45

• Acerca dos relatórios: página 53

• Exportar dados: página 55

O espaço de trabalho Reports do CareLink™ Pro permite-lhe transformar 
dados recolhidos dos dispositivos em informações clínicas úteis. Para 
saber quais os tipos de relatórios que pode criar, consulte Acerca dos 
relatórios, na página 53.

Os relatórios podem ser criados no ecrã, enviados directamente para 
uma impressora ou guardados em ficheiros de formato TIFF ou PDF 
que pode anexar a uma Ficha Médica Electrónica (Electronic Medical 
Record ou EMR). É possível criar vários tipos de relatório através de 
uma só operação.

Os dados visualizados nestes relatórios são captados a partir dos 
dispositivos do doente, das respectivas contas CareLink Personal 
ou de ambas as formas. 

Antes de começar

Se quiser criar um relatório que abranja os dados de um determinado 

período de tempo, terá de recolher os dados do dispositivo do doente 

referentes a esse período. É ainda necessário que o dispositivo do 

doente esteja ligado ao computador para obter os dados actualizados, 

antes de elaborar os relatórios.
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Estude atentamente a etapa Verificar as configurações do relatório
antes de elaborar um relatório. Nesta etapa poderá configurar de forma 
mais precisa um relatório, de modo a captar os dados do doente que 
pretende.

Criação de relatórios

As secções seguintes descrevem as etapas para a criação de um ou 

mais relatórios.

Abrir o espaço de trabalho Reports (Relatórios)      

1 Clique no separador do doente ou clique no botão OPEN PATIENT 
(Abrir doente) e faça duplo clique sobre o respectivo nome.

Surge o espaço de trabalho Reports (Relatórios) (ver exemplo 

na página 11).

NOTA: Para assegurar
que tem os dados mais
recentes do dispositivo

do doente recolhidos
a partir da conta

CareLink Personal do
doente, clique em SYNC

DATA (Sincronizar
dados).

Selecção do período do relatório        

1 Para alterar o período de tempo reflectido no(s) relatório(s), clique 
no menu pendente Duration (Duração) e seleccione a duração do 
período de tempo. (A duração máxima é de 12 semanas.)

2 As datas de início e fim do período são automaticamente definidas, 
a não ser que escolha a opção custom date range (intervalo de datas 
personalizado). 

NOTA: Se seleccionar
um intervalo de datas

mais extenso que
o permitido, verá uma

mensagem de erro. Ajuste
a duração ou as datas.

Se quiser definir um intervalo de datas personalizado, clique nos 
menus pendentes From (De) ou Through (Até) e selecccione o mês, 
data ou ano pretendidos. 

Data calendar (Calendário de dados)

A área de calendário de dados do espaço de trabalho Reports
(Relatórios) mostra uma janela de três meses de dados para os 
relatórios. Enumera dispositivos e mostra a quantidade de dados do 
dispositivo abrangidos pelos três meses seleccionados. Mostra ainda 
a duração do período abrangido pelo relatório, dentro dos três meses 
seleccionados.

Open Patient (Abrir doente)
botão

dados do dispositivo período abrangido pelo relatório

data calendar 
(calendário de dados) meses
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Uma sobreposição dos dados do dispositivo e do período do relatório 
significa que dispõe de dados para alguns ou para todos os períodos 
do relatório visualizados.

A área do calendário de dados mostra inicialmente os três últimos 
meses. Para ver outros meses, clique nos botões com setas em cada 
extremidade dos meses.

Seleccionar dados de cada fonte a incluir
1 Se o doente utilizar um medidor de GS que seja possível ligar à sua 

bomba de insulina, clique para escolher uma das opções seguintes 
para elaborar um relatório dos dados de GS deste medidor: 

– in the pump (na bomba): as vantagens desta selecção relacionam-se 
com o facto de apenas ter de efectuar a leitura de dados a partir 
da bomba do doente, de as leituras de GS virem acompanhadas 
da respectiva hora atribuída pela bomba de insulina e de as leituras 
estarem directamente ligadas a quaisquer cálculos da Ajuda de 
Bolus utilizados. Uma desvantagem é a não inclusão no relatório, 
caso ocorram dificuldades de comunicação entre a bomba de 
insulina e o medidor associado, das leituras de GS deste período 
problemático. Além disso, para as bombas de insulina MiniMed 
Paradigm anteriores à 522/722, todas as leituras de GS relacionadas 
com os cálculos da Ajuda de Bolus que não sejam objecto de 
reacção, não são incluídas no relatório.

– in the link meter(s) (no(s) medidor(es) ligado(s)): a vantagem 
desta selecção é o facto de todas as leituras guardadas no medidor 
ligado serem incluídas no relatório. A desvantagem relaciona-se 
com o facto de ser obrigatória a sincronização prévia dos relógios 
da bomba de insulina e do medidor para que seja possível 
correlacionar os dados do medidor e os dados da bomba de insulina. 
Tem ainda de efectuar a leitura separada dos dados da bomba 
e do medidor associado.

2 Para adicionar os dados do dispositivo aos relatórios, seleccione 
a caixa de verificação ao lado do dispositivo em questão. 

Não pode adicionar dispositivos que tenham sido excluídos devido 
à sua selecção na etapa 1. Para alterar esta situação, seleccione 
a outra opção do medidor associado.

Sobreposição entre os dados do 
dispositivo e o período do relatório

botões com setas
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3 Para excluir os dados do dispositivo dos relatórios, anule a selecção 

da caixa de verificação ao lado do dispositivo em questão. 

Não pode anular a selecção das caixas de verificação relacionadas 

com a opção seleccionada na etapa 1. Para alterar esta situação, 

seleccione a outra opção do medidor associado.

Verificar os dados do dispositivo        

1 Observe a área do calendário de dados do espaço de trabalho Reports
(Relatórios) para ver se o período abrangido pelo relatório se sobrepõe 
aos dados do dispositivo (consulte o exemplo da página 46).

2 Se as barras se sobrepuserem durante todo o período abrangido pelo 
relatório, tem dados para criar o(s) relatório(s). Pode clicar em NEXT 
(Seguinte) e passar a Verificação das configurações dos relatórios, 
na página 49.

3 Se as barras não se sobrepuserem ou se não se sobrepuserem o suficiente, 

tem algumas opções:

– ajustar o período abrangido pelo relatório (consulte Selecção
do período do relatório, na página 45).

– obter mais dados do dispositivo (consulte Obter dados adicionais 
do dispositivo, na página 47).

Obter dados adicionais do dispositivo         

1 Para obter mais dados de um dispositivo, clique no botão READ DEVICE 
(Ler dispositivo) associado ao dispositivo.

Surge a barra Read Device (Ler dispositivo).

AVISO: Cancele ou termine todos os bolus activos e índices basais temporários e limpe 
todos os alarmes activos. O funcionamento da bomba de insulina será suspenso durante 
a leitura. Completada a leitura, verifique se a bomba retomou o funcionamento.

ATENÇÃO: Não use o controlo remoto da bomba de insulina durante a leitura da bomba. 

Se a pilha da bomba de insulina estiver fraca, a bomba não enviará dados para o PC. 
Substitua a pilha se o ecrã de estado do dispositivo indicar que a energia da pilha está fraca.    

Barra READ DEVICE (Ler dispositivo)

Botão READ DEVICE 
(Ler dispositivo)
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2 Verifique se os dados do campo Choose port (Escolher porta) são os 
correctos para este dispositivo. 

Para alterar esta configuração, clique no menu pendente do campo 
e seleccione uma configuração diferente.

3 Assegure-se de que o dispositivo está ligado ao computador. 

4 Se o dispositivo for uma bomba de insulina, pode especificar a quantidade 
de dados que pretende obter do mesmo. Clique no menu pendente 
Amount of Data (Quantidade de dados) e seleccione uma quantidade.

NOTA: Se seleccionar
All available data (Todos

os dados disponíveis),
o sistema lê todos os

dados da bomba. Esta
acção sobrepõe

a gravação a todos os
dados duplicados

presentes no sistema.

5 Clique em READ DEVICE (Ler dispositivo). Leia atentamente a mensagem 
que surge no ecrã, uma vez que fornece instruções específicas para 
a leitura da bomba de insulina.

6 Siga as instruções e clique em OK. 

Surge a barra de progresso Read Device (Ler dispositivo).

Pode optar por cancelar a leitura em qualquer altura, clicando 
em CANCEL (Cancelar).

Surge uma mensagem, confirmando que a leitura está completa.

7 Clique em OK.

Os dados do dispositivo são agora visíveis no calendário de dados.

8 Clique em NEXT (Seguinte) no topo do espaço de trabalho Reports
(Relatórios).

É visualizada a etapa Verify Report Settings (Verificar configurações 

do relatório). Esta etapa permite assegurar que as configurações 

deste doente estão correctas antes de elaborar o(s) relatório(s).

linha de 
tempo

período da refeição 

campos para editar os períodos das refeições

períodos “ao deitar” e “ao acordar”
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Verificação das configurações dos relatórios

1 Assegure-se de que as configurações de Glucose Target (Objectivo 
de glicemia) estão nos valores pretendidos. Digite estes valores 
ou clique nas setas ascendente ou descendente nos campos Low
(Inferior) e High (Superior) para elevar ou baixar os valores.

NOTA: Pode ter cinco
períodos de refeição, no

máximo. Os períodos
predefinidos são
pequeno-lamoço,
almoço e jantar.

2 Para adicionar um novo período de refeição, clique em ADD MEAL 
(Adicionar refeição). Para editar um período de refeição existente, 
clique em qualquer ponto de um período de refeição disposto na 
linha de tempo.

O editor Meal Period (Períodos de refeição), localizado por baixo 
da linha de tempo, fica activo.

3 Digite texto ou clique nas setas para seleccionar as configurações 
pretendidas.

NOTA: Se apenas quiser
usar estas configurações

para esta refeição,
anule a selecção da

caixa de verificação ao
lado de Use these

parameters for all of this
patient’s meals (Usar

estes parâmetros para
todas as refeições

deste doente).

– Meal Name (Nome da refeição): nome que pretende atribuir 
ao período de refeição.

– Meal Time Period (Período de tempo da refeição): horas entre 
as quais decorre a refeição.

– Pre-Meal BG Target (mg/dL or mmol/L) (Objectivo de GS antes 
da refeição (mg/dl ou mmol/l): limites inferior e superior dos 
objectivos de glicemia do doente antes da refeição.

– Pre-Meal Analysis Period (Período de análise antes da refeição):
período de tempo em que a glicose será analisada antes do início 
de uma refeição. As leituras de glicose captadas durante este 
período são usadas na análise dos relatórios exaustivos.

– Post-Meal BG Target (mg/dL or mmol/L) (Objectivo de GS após 
a refeição (mg/dl ou mmol/l): limites inferior e superior dos 
objectivos de glicemia do doente após a refeição.

– Post-Meal Analysis Period (Período de análise após a refeição):
período de tempo em que a glicose será analisada após uma 
refeição. As leituras de glicose captadas durante este período são 
usadas na análise dos relatórios exaustivos.

NOTA: Os períodos das
refeições não podem

sobrepor-se, embora as
linhas de início e de fim

possam tocar-se. Os
períodos das refeições

têm de ter uma duração
mínima de 60 minutos.

É possível alterar a duração de um período de refeição estabelecido 

ou de um período “ao acordar” e “ao deitar”, clicando nos ponteiros 

de início ou de fim e arrastando e largando os ponteiros ao longo da 

linha de tempo. 



Guia do utilizador CareLink™ Pro    Espaço de trabalho Reports (Relatórios)      50

4 Para utilizar a configuração desta refeição em todas as outras refeições 

do doente, verifique se a caixa de verificação ao lado de Use these 

parameters for all of this patient’s meals (Utilizar estes parâmetros 

em todas as refeições deste doente) se encontra seleccionada.

5 Depois de ter criado ou editado um período de refeição, clique em 

SAVE (Guardar).

6 Para remover um período de refeição, clique em DELETE MEAL 

(Eliminar refeição). Clique em DELETE (Eliminar) quando lhe for 

pedido para confirmar.

7 O CareLink Pro conservará em memória estas configurações particulares 

até à próxima vez que elaborar um relatório para o mesmo doente. 

Para as guardar associadas a este doente, clique em SAVE SETTINGS 

(Guardar configurações).

8 Clique em NEXT (Seguinte) no topo do espaço de trabalho Reports

(Relatórios). 

Esta é a etapa de selecção e elaboração de relatórios do processo. 

Fornece uma lista de tipos de relatórios, além de uma Tabela de 

Dados que o ajuda a incluir ou excluir os dados de determinados dias 

do(s) relatório(s) Daily Detail (Diário exaustivos). 

seleccione o ponteiro de início ou de fim e arraste e largue 
o ponteiro ao longo da linha de tempo

linha de tempo

marcadores de leituras do medidor
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9 Para imprimir o ecrã, clique no ícone PRINT (Imprimir).

NOTA: Para alterar
a visualização de Data

Table (Tabela de dados),
clique em >> customize

columns (Personalizar
colunas). Consulte
Preferências para

a criação de relatórios,
na página 22.

Selecção de tipos de relatórios e datas de inclusão           

1 Seleccione a caixa de verificação ao lado do(s) relatório(s) que 

pretende incluir no conjunto de relatórios.

2 Se tiverem sido lidos dados de uma bomba de insulina ou monitor 

Guardian mais que uma vez durante este período abrangido pelo 

relatório, é possível que existam várias perspectivas do dispositivo: 

a. Verifique se a caixa de verificação ao lado de Device Settings 
Snapshot (Perspectiva das configurações do dispositivo) se 
encontra seleccionada. 

b. Clique na seta pendente e seleccione uma data e hora para 
a perspectiva. 

– Bombas de insulina: Seleccione uma perspectiva da bomba de 
insulina do doente.

– Guardian: Seleccione uma perspectiva do monitor Guardian do 
doente.

Se um dos campos se apresentar esbatido, não existem perspectivas 

disponíveis durante o período do relatório.

3 Percorra a Data Table (Tabela de dados) para rever as informações 

disponíveis para o relatório Daily Detail (Diário exaustivo). 

– Pode ordenar os dados de cada coluna. Clique no cabeçalho da 
coluna para ordenar os dados em ordem ascendente. Clique no 
cabeçalho de novo para ordenar os dados em ordem descendente.

Data Table (Tabela de dados)

ícone
imprimir
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NOTA: Se não existirem
dados para uma

determinada data, esta
última não poderá ser

seleccionada.

4 Seleccione a caixa de verificação nas linhas da tabela de dados para 

qualquer data que pretenda ver reflectida num relatório Daily Detail 

(Diário exaustivo). 

– Para incluir ou excluir todas as datas do relatório Daily Detail
(Diário exaustivo) com um clique, seleccione a caixa de verificação 
no topo da coluna da caixa de verificação da tabela de dados.

Elaboração de relatórios                                  

1 Depois de verificar as selecções de relatórios, clique em GENERATE 

REPORTS (Elaborar relatórios) no topo do espaço de trabalho Reports

(Relatórios).

Surge uma lista de opções.

2 Seleccione uma opção para pré-visualizar, imprimir ou guardar o(s) 

relatório(s).

Se tiver seleccionado Preview (Pré-visualização), surge a janela 

Report Preview (Pré-visualização de relatórios).

3 Clique nos botões com setas para navegar nos relatórios com várias 

páginas.

4 Clique num dos outros botões no topo da janela Report Preview

(Pré-visualização de relatórios) para guardar ou imprimir o(s) 

relatório(s).

5 Para fechar esta janela, clique no botão CLOSE (Fechar) no canto 

superior direito da janela.Botão CLOSE
preview (Fechar

pré-visualização)
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Acerca dos relatórios         

Esta secção contém uma descrição de cada relatório. O Guia de 

Consulta dos Relatórios inclui mais pormenores sobre os componentes 

dos relatórios, além de exemplos de relatórios. Pode aceder ao Guia 

de Consulta dos Relatórios através do software CareLink Pro:

1 Help > View Report Reference Guide (PDF)
(Ajuda > Ver Guia de Consulta dos Relatórios (PDF)). 

2 Seleccione um idioma para o Guia de Consulta dos Relatórios.

Os relatórios do CareLink Pro têm em comum os seguintes elementos: 

• Cabeçalho do relatório — O cabeçalho do relatório inclui dados 

identificativos, como o nome do relatório, o nome do doente 

e a origem dos dados.

• Carbohidratos e níveis de glicemia — Dentro dos gráficos e tabelas, 

as unidades de carbohidratos são visualizadas em itálico e os níveis 

de glicemia são visualizados a negrito.

• Dados de fim-de-semana — Os dias do fim-de-semana apresentam-se 

a negrito para que possa identificá-los facilmente.

• Legendas — Aparece uma legenda dos símbolos ao fundo de cada 

relatório. Embora um simbolo possa ser usado em vários relatórios, 

as legendas são específicas de cada relatório.

Relatório de adesão        

Este relatório apresenta dados que descrevem como as bombas de 
insulina e os sensores são usados e ainda os comportamentos do 
doente relevantes para a terapia. Respondem à pergunta, “Existem 
dados suficientes para facultar uma imagem rigorosa da forma como 
o doente utiliza a sua bomba de insulina e sensor, se for o caso?” 
Respondem ainda à pergunta, “Os doentes respeitam a terapia, 
conforme as instruções recebidas?” Indicam ainda se terá de falar 
com o doente sobre a forma como está a gerir a sua diabetes.

Relatório Perspectiva geral do sensor e medidor de glicose       

O relatório Perspectiva geral do sensor de medidor de glicose fornece 
uma representação gráfica das médias e dos níveis diários de glicemia 
recolhidos com medidor por um doente, decompostos por hora ao 
longo de 24 horas e relacionados com as refeições e padrões de sono. 
São ainda incluídas as estatísticas de utilização de insulina e das 
leituras de glicemia do doente. 
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É elaborada uma análise semelhante dos dados do sensor na primeira 

página deste relatório, se existirem dados de sensor disponíveis. 

Quando não existirem dados disponíveis sobre o sensor, a página 

de análise de dados do medidor aparecerá como a primeira página.

A(s) página(s) final/finais do relatório mostra(m) o nível e qualidade 

diária do controlo glicémico, de carbohidratos e insulina do doente. 

Cada página mostra como esse controlo varia em cada dia, ao longo 

de todo o período abrangido pelo relatório até um máximo de 14 dias 

por página.

Relatório do livro de registo        

O relatório do livro de registo inclui dados relativos à insulina, carbohidratos 

e glicemia do medidor de glicose para cada dia do período abrangido 

pelo relatório. Fornece um diário de eventos registados por hora, 

além de totais e médias diárias. Cada página contém até 14 dias. 

Se o período abrangido pelo relatório ultrapassar 14 dias, são criadas 

páginas adicionais.

Perspectiva das configurações do dispositivo

Este relatório apresenta uma perspectiva das configurações da bomba 

de insulina ou monitor Guardian REAL-Time do doente em relação 

a uma data e hora específicas. Isto pode ajudar a interpretar outros 

relatórios ou pode simplesmente documentar as configurações do doente. 

As configurações da bomba de insulina ou monitor são registadas 

apenas quando é efectuada a leitura do dispositivo. Se não for 

efectuada uma leitura do dispositivo durante o período abrangido 

pelo relatório, não ficarão disponíveis quaisquer configurações.

Daily Detail Report (Relatório diário exaustivo)        

O relatório diário exaustivo apresenta os dados de glicemia, quantidades 

de carbohidratos e a utilização da insulina pelo doente para o dia 

seleccionado. É elaborado um relatório separado para cada dia 

seleccionado na Data Table (Tabela de dados).

O relatório diário exaustivo contém uma perspectiva detalhada de cada 

dia seleccionado. Permite-lhe concentrar-se num dia em particular, 

se achar que ocorreu algo de interesse para a terapia do doente.
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Exportar dados

É possível exportar dados do dispositivo captados e guardados pelo 
CareLink Pro. Assim, dispõe de todos os dados do dispositivo de um 
doente para utilizar como estatísticas ou na criação de tabelas ou 
relatórios especializados. O ficheiro .csv pode ser importado para 
o Microsoft Excel ou determinados programas de estatísticas clínicas 
onde os respectivos dados podem ser tratados.

O ficheiro .csv contém dados que registam as acções do dispositivo. 
Por exemplo, enumera o registo das leituras do medidor de glicose, 
a recepção do valor da leitura do medidor pela bomba de insulina ou 
a alteração do índice basal.

NOTA: Esta é uma
função avançada e exige
que se familiarize com
os dados não tratados

do dispositivo. É ainda
necessário que tenha

bastante experiência na
utilização do software

para o qual vai importar
o ficheiro .csv.

Siga estas etapas para utilizar a função de exportação do CareLink Pro:

1 Clique no separador do doente ou no botão OPEN PATIENT (Abrir doente) 
e faça duplo clique sobre o respectivo nome.

2 Assegure-se de que o espaço de trabalho Reports (Relatórios) está aberto.

3 Use os campos Duration (Duração) ou From/Through (De/Até) para 
definir as datas e a duração do relatório.

A duração máxima que é possível seleccionar é de 12 semanas.

4 Clique na hiperligação export selected data (Exportar dados seleccionados).

Surge a caixa de diálogo Export Data to CSV File (Exportar dados 
para ficheiro CSV).

5 Para alterar o local onde vai guardar o ficheiro .csv no computador, 
clique na seta à direita do campo Save in (Guardar em) e seleccione 
uma localização.

6 Se pretender mudar o nome do ficheiro, digite-o na caixa File name
(Nome do ficheiro).

7 Clique em SAVE (Guardar).

NOTA: Para mais
informações sobre os

dados visualizados nos
ficheiros CSV, consulte

Dados CSV, na página 67.

O ficheiro .csv fica guardado no computador, no local seleccionado. 

Pode agora importá-lo para qualquer programa que suporte este tipo 

de ficheiro.

hiperligação export 
selected data 
(Exportar dados 
seleccionados)
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Administração do sistema 8

Neste capítulo encontrará
• Antes de começar: página 56

• Instalação de actualizações do software: página 57

• Realização de cópias de segurança e restauro da base de dados: 
página 58

É importante efectuar regularmente cópias de segurança da base 

de dados do CareLink™ Pro. A base de dados guarda todos os dados 
do sistema que tenham vindo a acumular-se nos registos do doente, 
incluindo os dados do perfil, os dados recolhidos no dispositivo e as 
configurações dos relatórios. 

O CareLink Pro permite-lhe guardar cópias da base de dados e restaurá-la.

É também importante que disponha da versão mais recente do 
CareLink Pro. As versões actualizadas são disponibilizadas periodicamente 
e podem conter melhorias importantes. Pode optar por procurar 
actualizações ou ser avisado da sua disponibilização.

Antes de começar

É aconselhável estabelecer um plano regular para a realização de cópias 
de segurança. Tal garantirá a regularidade da realização de cópias de 
segurança e reduzirá o risco de perda de dados. 

Durante a realização de cópias de segurança ou durante um restauro, 
o CareLink Pro detecta outros utilizadores que possam estar a usar 
o software noutros computadores e pergunta-lhes se pretendem guardar 
o seu trabalho. Apesar disso, é aconselhável verificar a existência de 
outros utilizadores antes de iniciar qualquer um destes processos.



Guia do utilizador CareLink™ Pro    Administração do sistema      57

Instalação de actualizações do software

Recepção automática de actualizações

Estarão disponíveis actualizações ocasionais do software CareLink Pro. 

Quando surgir um aviso de uma actualização, proceda da seguinte 

forma para transferir a última versão do software.

NOTA: Efectue uma
cópia de segurança da

base de dados antes de
instalar uma actualização

do software. Consulte
Efectuar cópias de

segurança de uma base
de dados, na página 58.

1 Verifique se dispõe de uma ligação activa à Internet no computador.

2 A mensagem CareLink Pro Update (Actualização do CareLink Pro) 

surge quando existe uma actualização ao CareLink Pro. Esta mensagem 

permite-lhe optar por transferir a actualização.

3 Clique em DOWNLOAD (Transferir). (Se clicar em CANCEL (Cancelar), 

a notificação de actualização será encerrada. Poderá transferir 

a actualização mais tarde.)

Surge uma mensagem de aviso que recomenda a realização de uma 

cópia de segurança da base de dados.

4 Clique em YES (Sim) para criar uma cópia de segurança da base de dados 

(consulte Efectuar cópias de segurança de uma base de dados, 

na página 58 para obter mais informações sobre este procedimento). 

Clique em NO (Não) se não quiser efectuar uma cópia de segurança 

dos seus dados.

Surge uma mensagem, confirmando que a nova versão do CareLink 

Pro foi transferida.

5 Para começar a utilizar a versão mais recente do CareLink Pro, clique 

em YES (Sim) para encerrar e abrir de novo a aplicação de software. 

Clique em NO (Não) se preferir aguardar para reiniciar o CareLink Pro.

Desactivar as actualizações automáticas

Se não pretender receber notificações automáticas das actualizações 

do CareLink Pro, siga estas etapas:

1 Seleccione Tools > Options (Ferramentas > Opções).

2 Clique no separador General (Geral).

3 Na secção Communications (Comunicações), limpe a caixa de 

verificação situada junto de Automatically check for software 

updates (Verificar automaticamente as actualizações de software).
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Verificação manual de actualizações

Pode verificar manualmente se existem actualizações do CareLink Pro, 

em qualquer altura.

NOTA: Efectue uma
cópia de segurança da

base de dados antes de
instalar uma actualização

do software. Consulte
Efectuar cópias de

segurança de uma base
de dados, na página 58.

1 Verifique se dispõe de uma ligação activa à Internet no computador.

2 Seleccione Tools > Check for Software Updates
(Ferramentas > Verificar actualizações de software).

3 Receberá uma mensagem se não existirem actualizações disponíveis 

no momento. Se existir uma actualização, surge uma mensagem de 

CareLink Pro Update (Actualização do CareLink Pro). 

4 Siga o procedimento descrito em Recepção automática de 

actualizações, na página 57.

Realização de cópias de segurança e restauro 
da base de dados

Efectuar cópias de segurança de uma base de dados     

As seguintes etapas permitem-lhe efectuar cópias de segurança 

da actual base de dados, em local a seleccionar.

1 Certifique-se que todos os registos dos doentes estão fechados.

2 Seleccione Tools > Backup Database (Ferramentas > Efectuar cópia 

de segurança da base de dados).

NOTA: As cópias de
segurança da base de

dados podem ser
guardadas numa

unidade de rede ou num
suporte amovível de

armazenamento de
dados (DVD, CD,

unidade USB, etc.).

3 Para guardar a cópia de segurança num local diferente do computador, 

clique na seta à direita do campo Save in (Guardar em) e seleccione 

uma nova localização.

4 Se pretender mudar o nome do ficheiro de segurança, digite-o na 

caixa File name (Nome do ficheiro).

5 Clique em SAVE (Guardar). É visualizada uma barra de progresso 

enquanto a base de dados é guardada.

Surge uma mensagem quando a cópia de segurança estiver completa.

6 Clique em OK para fechar a mensagem.
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Restaurar uma base de dados         

A actual base de dados pode ter de ser substituída se depois não for 

possível aceder à mesma ou usá-la.

ATENÇÃO: Ao restaurar uma base de dados a partir de uma cópia de segurança, perde 
todos os novos dados criados desde que efectuou a cópia de segurança seleccionada.

As seguintes etapas permitem-lhe seleccionar uma cópia de segurança 

para substituir a actual base de dados.

1 Certifique-se que todos os registos dos doentes estão fechados.

2 Seleccione Tools > Restore Database (Ferramentas > Restaurar base 

de dados). 

3 Seleccione o ficheiro de segurança que pretende usar para substituir 

a actual base de dados (habitualmente, o mais recente).

4 Clique em OPEN (Abrir). Surge uma mensagem de aviso. Clique em OK.

5 É visualizada uma barra de progresso enquanto a base de dados está 

a ser restaurada.

Surge uma mensagem quando a operação de restauro da base de dados 

estiver concluída.

6 Clique em OK para fechar a mensagem.

Quando o sistema está indisponível                

Se tentar inicializar o sistema enquanto outro utilizador estiver a criar 

uma cópia de segurança ou um restauro, receberá uma mensagem 

com a notificação de que o sistema não está disponível. Não conseguirá 

aceder ao sistema até a tarefa estar concluída.

Efectue uma das seguintes acções:

• aguarde que o processo termine e que o sistema fique disponível;

• clique em CANCEL (Cancelar) para sair e tentar de novo mais tarde.
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Resolução de problemas 9

Neste capítulo encontrará
• Erros gerais na utilização da aplicação: página 60

• Erros na leitura de dispositivos: página 61

• Erros na criação de relatórios: página 64

• Erros relativos a cópias de segurança e restauros: página 64

• Desinstalar o software: página 65

Este capítulo foi concebido para o ajudar a resolver problemas que 

possam ocorrer durante a utilização do software CareLink™ Pro. Contém 

ainda instruções para desinstalar o software CareLink Pro, caso tal 

seja necessário.

Erros gerais na utilização da aplicação

Autorização para transferir actualizações de software da Internet

Se tentar transferir uma actualização de software da Internet, pode 

receber uma mensagem indicando que não tem a necessária autorização 

para o fazer. É preciso ter o estatuto de administrador no sistema 

para transferir as actualizações do software CareLink Pro.

1 Encerre a aplicação de software CareLink Pro e reinicie o seu 

computador. 

2 Peça a uma pessoa com estatuto de administrador para iniciar uma 

sessão no computador.

3 Siga as instruções de Instalação de actualizações do software, 

na página 57.
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Not connected to the database (Não está ligado à base de dados)

Uma mensagem de erro informando que não se encontra ligado à base 

de dados indica um dos seguintes problemas:

• A base de dados foi deslocada. A base de dados tem de estar no 

mesmo local que foi seleccionado durante a instalação do software 

CareLink Pro. Se tiver sido deslocada, tem de ser novamente colocada 

no local seleccionado durante a instalação.

• You are not connected to the network drive where the database is 

located (Não está ligado à unidade de rede onde está localizada 

a base de dados). Se a base de dados estiver localizada numa unidade 

de rede, é possível que ocorram ocasionalmente problemas na rede 

que impeçam o acesso à unidade. Contacte o seu departamento de 

informática para que o ajudem a restabelecer a ligação à unidade de 

rede onde está localizada a base de dados. 

Esqueceu-se da palavra-passe do médico para aceder ao CareLink Pro

Se ninguém se lembrar da palavra-passe do médico para iniciar uma 

sessão no CareLink Pro, será necessário reinstalar o software CareLink 

Pro e criar uma nova base de dados. Uma vez reinstalado o software, 

não conseguirá aceder a quaisquer informações de doentes que se 

encontravam na base de dados anterior. Guarde a palavra-passe criada 

durante a nova instalação num local do escritório para que não perca 

dados futuros. 

Erros na leitura de dispositivos

Erro na leitura de dispositivo Explicação

The selected serial port 
could not be opened. Another 
operation might be in progress 
on that port. Please wait 
until the port is available, or 
select another port. (Não foi 
possível abrir a porta série 
seleccionada. Pode estar em 
curso outra operação nessa 
porta. É favor aguardar até 
a porta ficar disponível ou 
seleccionar outra porta.)

Verifique se a porta de comunicação seleccionada 
não está a ser usada por outro programa ou 
seleccione outra porta. Experimente reiniciar 
o computador que está a utilizar e tentar novamente 
efectuar a leitura do dispositivo. O hardware 
(cabo, etc.) de ligação à porta ou a própria porta 
podem estar danificados. Ligue o hardware a outra 
porta e tente novamente efectuar a leitura do 
dispositivo para ajudar a determinar o problema. 
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Auto Detect could not find 
the device on any available 
port. Please check the cable 
connection, device battery 
& status and try again, or 
try specifying a serial port. 
(A detecção automática 
não conseguiu localizar 
o dispositivo numa porta 
disponível. É favor verificar 
a ligação do cabo, a pilha 
e o estado do dispositivo 
e tentar de novo ou tentar 
especificar uma porta série.) 

Verifique a ligação entre o cabo e o PC e verifique 
o bom estado da bateria do dispositivo. Se estiver 
em bom estado, experimente especificar a porta 
série do PC à qual o cabo está ligado, em vez de 
seleccionar a detecção automática.

Device not found at selected 
serial port. Please check the 
cable connection, device 
battery & status and try again, 
try selecting a different 
port, or try to Auto Detect 
the device. (Dispositivo não 
encontrado na porta série 
seleccionada. É favor verificar 
a ligação por cabo, a pilha 
e o estado do dispositivo 
e tentar de novo ou tentar 
efectuar a detecção automática 
do dispositivo.)

Verifique a ligação entre o cabo e o PC e verifique 
o bom estado da bateria do dispositivo. Se estiver 
em bom estado, experimente seleccionar um 
número de porta série diferente no PC ou escolher 
a opção de detecção automática.

Unable to communicate with 
the device. Please ensure 
you’ve attached and selected 
the correct device, check 
the cable connection, device 
battery and status, and try 
again. (Não foi possível 
comunicar com o dispositivo. 
É favor verificar se fixou 
e seleccionou o dispositivo 
correcto, verificar a ligação 
por cabo, o estado e a pilha 
do dispositivo e tentar de novo.)

Verifique todas as configurações seleccionadas 
para a leitura do dispositivo, incluindo o nome 
do dispositivo, número de série e tipo de ligação. 
Verifique ainda se o dispositivo, o cabo e o PC 
estão devidamente ligados. Verifique se a pilha 
e o estado do alarme do dispositivo se encontram 
em boas condições. Tente novamente efectuar 
a leitura.

Unexpected response... 
retrying (n%) (Resposta 
inesperada... a tentar de 
novo (n%))

Foi lido um valor inesperado no dispositivo. O sistema 
tenta uma nova comunicação até o utilizador 
cancelar esta acção ou até a comunicação ter 
êxito.

Erro na leitura de dispositivo Explicação
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The communication device 
was found, but the pump 
(<serial #>) is not responding. 
Please verify the pump’s 
serial number, place the pump 
closer to the communication 
device to minimize interference, 
check pump battery and 
status. (O dispositivo de 
comunicação foi localizado 
mas a bomba de insulina 
(n.º de série) não está 
a responder. É favor 
verificar o número de série 
da bomba, aproximar 
a bomba do dispositivo 
de comunicação para minimizar 
a interferência, verificar 
a pilha e o estado da bomba.)

Verifique se foi introduzido o número de série 
correcto da bomba de insulina. Se não tiver sido 
introduzido o número correcto, reintroduza 
o número de série correcto. Se o número de série 
estiver correcto, experimente aproximar a bomba 
do dispositivo de comunicação ou afastar o dispositivo 
de comunicação e a bomba de insulina da possível 
fonte de interferência (como outros dispositivos 
de RF) ou ainda verificar o estado de administração 
e a pilha da bomba.

This pump is delivering 
a temp basal. Please cancel 
the temp basal or wait until 
it completes, and then try 
again. (Esta bomba de 
insulina está a administrar 
um índice basal temporário. 
É favor cancelar o índice 
basal temporário ou aguardar 
até que o mesmo se complete 
e tentar de novo.)

A bomba de insulina na qual está a tentar 
efectuar a leitura está a administrar um índice 
basal temporário. Aguarde o final da administração 
do índice basal temporário para efectuar a leitura 
da bomba ou cancele o índice basal temporário 
e efectue depois a leitura.

This pump has active errors 
or alarms. Please clear the 
alarms and try again. (Esta 
bomba de insulina tem erros 
ou alarmes activos. É favor 
eliminar os alarmes e tentar 
de novo.)

Existem alarmes activos na bomba de insulina que 
impedem a leitura. Leia as instruções sobre alarmes 
para apagar o alarme. Apague o alarme e tente 
efectuar novamente a leitura da bomba.

This pump is delivering 
a bolus. Please cancel the 
bolus or wait until it completes, 
and then try again. (Esta bomba 
de insulina está a administrar 
um bolus. É favor cancelar 
o bolus ou aguardar até que 
o mesmo se complete e tentar 
de novo.)

A bomba de insulina na qual está a tentar efectuar 
a leitura está a administrar um bolus. Aguarde 
o final da administração do bolus para efectuar 
a leitura da bomba ou cancele o bolus e efectue 
depois a leitura.

The device returned invalid 
entries; all data read will be 
discarded. (O dispositivo 
enviou entradas inválidas; 
todos os dados lidos serão 
eliminados.)

Contacte o seu representante local (consulte 
Assistência, na página 3). 

Erro na leitura de dispositivo Explicação
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Erros na criação de relatórios

Multiple data entries for the same date (Várias entradas de dados para 
a mesma data)

Se um só dispositivo apresentar várias entradas de dados para a mesma 

data e hora, o sistema considera que existe um conflito insolúvel. 

Os relatórios criados com os dados deste dispositivo omitirão a porção 

de dados sobrepostos. 

Pode tentar ajustar o período abrangido pelo relatório para evitar os 

dados sobrepostos. Ou pode retirar o dispositivo do sistema e adicioná-lo 

de novo para apagar as leituras anteriores.

System is going to ignore data (O sistema vai ignorar os dados)

Se a hora num dispositivo tiver sido alterada, causando sobreposições 

ou lacunas nos dados com duração igual ou superior a três horas, 

o sistema não inclui essa porção de dados ao criar relatórios.

Erros relativos a cópias de segurança e restauros

The database cannot be locked (Não é possível bloquear a base de dados)

Isto significa que está a usar o sistema num ambiente com vários 

utilizadores no qual existem outros utilizadores com uma sessão iniciada. 

O sistema não permite que se efectue uma cópia de segurança da 

base de dados enquanto outros utilizadores estiverem a realizar tarefas 

que possam afectar a base de dados. Depois que todos os utilizadores 

saírem do CareLink Pro, poderá proceder à cópia de segurança da base 

de dados.

A database backup or restore is not completing (Uma cópia de 
segurança ou restauro da base de dados não está a ser completado)

Outros utilizadores não podem iniciar sessão e a cópia de segurança 

ou restauro não se completam. Contacte a linha de assistência ou 

o seu representante local (consulte Assistência, na página 3).

A restore database fails (O restauro da base de dados falhou)

O ficheiro com a cópia de segurança da base de dados que está 

a tentar utilizar no processo de restauro está corrompido. Tente 

proceder ao restauro com outro ficheiro de cópia de segurança.
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Desinstalar o software

Se precisar de desinstalar o CareLink Pro, complete as seguintes etapas:

1 Abra o Painel de controlo através do menu Iniciar do Windows.

2 Seleccione Adicionar ou remover programas. Abre-se a janela 

de Adicionar ou remover programas do Windows.

3 Percorra a lista até Medtronic Carelink Pro e clique neste nome.

4 Clique em REMOVE (Remover). Surge o Assistente de desinstalação.

5 Clique em NEXT (Seguinte). Surge uma mensagem pedindo-lhe que 

confirme se pretende remover a aplicação.

6 Clique em YES (Sim). O programa de desinstalação é executado 

e remove o programa e respectivos ficheiros do seu computador. 

No final do processo, surge uma mensagem no ecrã do Assistente 

confirmando a desinstalação.

7 Clique em FINISH (Terminar).
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Tabela de ícones
Os ícones e símbolos dos rótulos da embalagem e do equipamento 

são descritos na tabela seguinte:

Descrição Ícone

Um por contentor/embalagem (1x) 

Atenção: Ver Instruções de utilização

CD incluído

Documentos importantes incluídos

Número de catálogo REF

Marca CE como dispositivo médico 
atribuída por organismo notificado
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Dados CSV A

Este apêndice descreve os dados do CareLink™ Pro que são visualizados 

quando se exportam os dados para o formato CSV. 

Definições dos dados das colunas

Cabeçalho da coluna Definição

Index (Índice remissivo) A ordem pela qual os dados foram gravados no 
dispositivo.

Date (Data) A data na qual os dados foram gravados no 
dispositivo.

Time (Hora) A hora à qual os dados foram gravados no dispositivo.

New Device Time (Nova hora 
do dispositivo)

A nova hora e data, se estas tiverem sido 
alteradas no dispositivo.

BG Reading (mg/dL or 
mmol/L) (Leitura GS 
(mg/dl ou mmol/l))

A leitura da glicose no sangue registada pelo 
medidor, pelo Guardian ou pela bomba. Se os 
dados forem provenientes de uma bomba ou do 
Guardian, esta coluna reflecte as GS manuais e as 
GS recebidas de um medidor ligado. 

Linked BG Meter ID 
(ID de medidor de GS ligado)

Número de série do medidor de glicose no sangue 
que envia uma leitura da glicemia específica para 
o dispositivo.

Basal Rate (U/h) 
(Índice basal (U/h))

O índice de administração de insulina basal activa 
em unidades por hora.

Temp Basal Amount 
(Quantidade do índice 
basal temporário) 

Se tiver sido aplicado um índice basal temporário 
na bomba, este valor representa a quantidade do 
índice basal temporário. 

Temp Basal Type 
(Tipo de basal temporário)

O tipo de ajuste do índice basal temporário 
(índice de insulina ou percentagem de basal).

Temp Basal Duration (m) 
(Duração do índice basal 
temporário (m))

A duração em minutos da administração da insulina 
basal temporária (consulte o tipo acima referido).

Bolus Type (Tipo de bolus)
Tipo de administração de insulina de bolus 
[Normal, Quadrada, Dupla (parte normal), 
ou Dupla (parte quadrada)].
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Bolus Volume Selected (U) 
(Volume de bolus 
seleccionado (U))

Número de unidades de insulina seleccionadas 
para administração durante a administração da 
insulina de bolus.

Bolus Volume Delivered (U) 
(Volume de bolus 
administrado (U))

Número de unidades de insulina efectivamente 
administradas durante a administração da insulina 
de bolus.

Programmed Bolus Duration (h) 
(Duração programada do 
bolus (h))

Duração de um bolus quadrado ou da porção 
quadrada de um bolus de onda dupla.

Prime Type 
(Tipo de enchimento)

Manual ou fixo. O manual é usado imediatamente 
após uma rebobinagem, para encher o cateter 
de infusão com insulina antes de o inserir. O fixo 
é usado após a inserção do cateter de infusão, 
para encher a cânula maleável com insulina 
após a remoção da agulha introdutora.

Prime Volume Delivered (U) 
(Volume de enchimento 
administrado (U))

Número de unidades de insulina efectivamente 
administradas durante o enchimento.

Alarm (Alarme) Nome do alarme ocorrido.

Suspend (Suspender) Identifica o estado de suspensão da bomba.

Rewind (Rebobinar) Data e hora em que o dispositivo foi rebobinado.

BWZ Estimate (U) 
(Estimativa da 
Ajuda de Bolus (U))

A estimativa da insulina de bolus calculada pela 
função Ajuda de Bolus da bomba de insulina 
Paradigm.

BWZ Target High BG (mg/dL 
or mmol/L) (Objectivo 
superior de GS da Ajuda de 
Bolus (mg/dl ou mmol/l))

Configuração do limite superior do intervalo de 
objectivos de glicemia, utilizado pela função 
Ajuda de Bolus.

BWZ Target Low BG (mg/dL 
or mmol/L) (Objectivo 
inferior de GS da Ajuda de 
Bolus (mg/dl ou mmol/l))

Configuração do limite inferior do intervalo de 
objectivos de glicemia, utilizado pela função 
Ajuda de Bolus.

BWZ Carb Ratio (Taxa de 
carbohidratos da Ajuda de 
Bolus)

Configuração para a taxa de carbohidratos/insulina. 
Se as unidades usadas forem gramas, a taxa 
é o número de gramas compensadas por uma 
unidade de insulina. Se as unidades usadas forem 
porções, a taxa é o número de unidades de insulina 
utilizadas para compensar uma porção de 
carbohidratos.

BWZ Insulin Sensitivity 
(Sensibilidade à insulina 
da Ajuda de Bolus)

Configuração da sensibilidade à insulina. 
A sensibilidade à insulina é a quantidade da 
redução do nível de glicemia conseguida com uma 
unidade de insulina. Esta é utilizada pela função 
Ajuda de Bolus.

BWZ Carb Input (Entrada de 
carbohidratos da Ajuda de 
Bolus)

Quantidade de carbohidratos introduzida na 
Ajuda de Bolus e utilizada para estimar um bolus.

BWZ BG Input (mg/dL or 
mmol/L) (Entrada de GS da 
Ajuda de Bolus (mg/dl ou 
mmol/l))

Leitura da glicemia quando introduzida na Ajuda 
de Bolus e utilizada para estimar um bolus.

Cabeçalho da coluna Definição
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Mais informações acerca dos ficheiros CSV 
exportados pelo CareLink Pro

O título no topo dos ficheiros CSV inclui os seguintes dados:

• nome do doente

• lista de dispositivos seleccionados e respectivos números de série

• intervalo de datas seleccionado

Cada bloco de colunas apresenta um título que inclui o seguinte:

• nome do dispositivo a que se refere o bloco de dados

• número de série desse dispositivo 

Se os dados não forem visualizados conforme o previsto

São vários os factores que podem fazer com que os dados dos CSV 

sejam visualizados de forma diferente da prevista.

• As alterações da data ou hora no dispositivo podem influenciar 

a sequência dos registos ou fazer com que sejam visualizados registos 

fora do intervalo de datas seleccionado;

• se existirem grandes intervalos entre leituras sucessivas do dispositivo, 

os dados podem ser apresentados em vários blocos.

BWZ Correction Estimate (U) 
(Estimativa de correcção da 
Ajuda de Bolus (U))

Unidades de insulina de bolus a administrar para 
corrigir o nível de glicemia, conforme os cálculos 
da Ajuda de Bolus.

BWZ Food Estimate (U) 
(Estimativa de alimentos 
da Ajuda de Bolus (U))

Unidades de insulina de bolus a administrar para 
compensar as previsões de consumo de carbohidratos, 
conforme os cálculos da Ajuda de Bolus.

BWZ Active Insulin (U) 
(Insulina activa da Ajuda 
de Bolus (U))

Cálculo da quantidade de insulina activa 
proveniente de administrações anteriores de 
insulina de bolus e ainda presente no organismo, 
ao determinar a estimativa da quantidade de 
bolus através da função Ajuda de Bolus.

Sensor Calibration BG 
(mg/dL or mmol/L) 
(GS de calibração do sensor 
(mg/dl ou mmol/l))

O valor de GS usado para calibrar o sensor em 
mg/dl ou mmol/l.

Sensor Glucose (mg/dL or 
mmol/L) (Glicose do sensor 
(mg/dl ou mmol/l))

O valor de glicose do sensor.

ISIG value (Valor ISIG) Sinais de entrada (ISIG), a serem lidos no sensor, 
medidos em nanoamperes (nA).

Cabeçalho da coluna Definição
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Glossário

A
A1c   Hemoglobina glicosada

Análise de HbA1c  Análise A1c da hemoglobina, usada para interpretar 
o controlo da glicemia ou a média de níveis ao longo de um período 
de 2 a 3 meses.

Análise de A1c  Análise A1c da hemoglobina, usada para interpretar 
o nível de glicemia ao longo de um período de tempo.

Área média por baixo da curva (“Area Under the Curve” ou AUC)  
Representa a quantidade média de exposição a hiperglicemia ou 
hipoglicemia durante o período de transmissão do sensor.

Aviso de calibração   O valor do aviso de calibração é o período de 
tempo que terá de decorrer antes que o actual valor de calibração 
expire, quando o utilizador pretende ser recordado da necessidade de 
calibração mediante a emissão, pela bomba, de um alarme METER BG BY 
(Medir GS às). Por exemplo, se o aviso de calibração for configurado 
para duas horas, o alerta METER BG BY (Medir GS às) será emitido 
duas horas antes de a calibração ser necessária.

Aviso de nível baixo no reservatório  Aviso programável que notifica 
o utilizador com um alerta quando resta no reservatório da bomba de 
insulina um número específico de unidades ou quando resta uma 
determinada quantidade de tempo para o reservatório ficar vazio.

B
Bolus áudio  A bomba de insulina pode ser programada para que 
o utilizador ouça um sinal sonoro ao seleccionar uma quantidade 
de insulina de bolus (por exemplo, 0,5 ou 1,0 unidade) para ser 
administrada. Esta função é útil quando é difícil ver os botões da 
bomba.

Bolus de alimentação  Uma dose de insulina administrada para 
compensar a subida previsível da glicemia que ocorre após a ingestão 
de alimentos.

Bolus de correcção  Quantidade de insulina necessária para restaurar 
os valores normais de glicemia em caso de um nível elevado de glicemia.
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Bolus de Onda Dupla (Dual Wave®) Combinação de um bolus normal 
que é administrado imediatamente, e seguido por um bolus de Onda 
Quadrada. A componente de Onda Quadrada é administrada uniformemente 
ao longo de um período de tempo.

Bolus de Onda Quadrada (Square Wave®) Bolus administrado de 
maneira uniforme ao longo de um período de tempo especificado pelo 
utilizador (de 30 minutos a 8 horas). 

Bolus expresso  Método de administração de um qualquer tipo de 
bolus, usando o botão de bolus expresso da bomba de insulina.

Bolus Fácil (Easy Bolus™) Método de administração de um bolus 
normal com o botão Bolus Fácil da bomba.

Bolus manual  Item opcional disponível no MENU BOLUS quando 
o Bolus Wizard está activado. Método de programar um bolus sem 
o Bolus Wizard. 

Bolus máximo  A quantidade máxima de insulina de bolus que 
a bomba administrará de uma só vez (definida pelo utilizador).

Bolus Normal  Administração imediata de uma quantidade 
especificada de unidades de insulina. 

C
CH Carbohidratos.

Com-Station  Dispositivo utilizado para transferir dados da bomba de 
insulina MiniMed 508 e de medidores capilares de outros fabricantes 
para o computador.

ComLink   Dispositivo emissor-receptor de radiofrequência (RF) usado 
para transferir dados da bomba de insulina Paradigm ou do sistema 
Guardian REAL-Time CGM para o computador.

Componente de onda quadrada  A segunda parte de um bolus de Onda 
Dupla. A componente de Onda Quadrada é administrada uniformemente 
ao longo de um período de tempo após a administração da componente 
imediata.

Concentração de insulina  Potência ou tipo da insulina que o médico 
prescreveu para o utilizador. Esta afecta o índice de insulina administrado 
pela bomba. Se a concentração de insulina do utilizador se alterar, 
será necessário reprogramar na bomba os padrões basais e os índices 
máximos do bolus e basal.

CareLink™ Personal  Serviço online que permite a gestão dos dados da 
diabetes através da Internet.

CareLink™ USB  Dispositivo utilizado para enviar dados armazenados 
numa bomba de insulina Medtronic Diabetes da série Paradigm ou num 
monitor Guardian REAL-Time, para o software CareLink™ através de 
uma porta USB do computador.

Cateter de infusão  Dispositivos usados para introduzir e fixar uma 
cânula sob a pele e para transportar a insulina até ao local de 
inserção através de um tubo que parte da bomba de insulina.
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D
Dose de insulina basal Uma infusão contínua de insulina administrada 
automaticamente por hora por uma bomba de insulina, com base em 
perfis pré-programados e índices personalizados definidos na bomba. 
A bomba administra uma infusão diária de insulina que, geralmente, 
supre as necessidades “de fundo” durante períodos de jejum (ou seja, 
durante a noite e entre as refeições).

E
Enviar  Processo de transferência de dados da bomba de insulina ou 
medidor para o servidor CareLink™ Personal.

Etapa  Incremento de insulina que é definido e usado pelo utilizador 
para administrar o Bolus Fácil.

F
Factor de bolus de correcção (factor de sensibilidade)  Valor 
da redução do seu nível de glicemia conseguido com 1,0 unidade 
de insulina. Este factor é utilizado para calcular a quantidade de 
um bolus de correcção quando o seu nível de glicemia é elevado.
(Nível de GS) – (Objectivo de GS) = X. 
X ÷ (factor do bolus de correcção) = 
quantidade do bolus de correcção

G
Glicemia elevada A bomba emitirá um alarme se o sensor indicar 
que o nível de glicose do sensor do utilizador é igual ou superior 
a este valor. Dispõe da opção de activar ou desactivar esta função.

Glicose baixa  A bomba de insulina emitirá um alarme se o sensor 
indicar que o nível de glicose do utilizador é igual ou inferior a este 
valor. Dispõe da opção de activar ou desactivar esta função.

GS Glicose no sangue.

H
HbA1c   Hemoglobina glicosada

Hiperglicemia Nível elevado de glicose no sangue demonstrado através 
da monitorização dos níveis de glicemia na presença ou ausência dos 
seguintes sintomas: náuseas, vómitos, visão turva, dores de cabeça, 
perturbações gástricas, micção frequente de grandes quantidades de 
urina e letargia. 

Hipoglicemia  Nível baixo de glicose no sangue demonstrado através 
da monitorização dos níveis de glicemia na presença ou ausência dos 
seguintes sintomas: fome excessiva, tremores, transpiração, visão 
“instável”, sensação de cabeça vazia, dores de cabeça, dificuldades 
na articulação da fala, alterações súbitas de humor ou da personalidade.
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I
Identificação do transmissor (ID transm)   Indica o número de série 
do transmissor que está a ser utilizado.

Índice basal  Configuração da bomba de insulina que permite uma 
infusão de insulina contínua de modo a manter a estabilidade da 
glicemia entre refeições e durante a noite. A insulina basal imita 
a administração de insulina pelo pâncreas que supre todas as 
necessidades de insulina do corpo não relacionadas com a ingestão 
de alimentos.

Índice basal temporário (basal temp)  Insulina basal temporária 
única com uma quantidade e duração especificadas. Utilizada para 
suprir as necessidades de insulina para actividades ou condições 
especiais que não fazem parte da rotina diária normal.

Insulina basal máxima  A quantidade máxima de insulina basal que 
a bomba de insulina administrará de uma só vez. (Definida pelo 
utilizador.)

Insulina de bolus  Uma dose de insulina administrada para compensar 
uma subida previsível da glicemia (como acontece após uma refeição 
ou lanche) ou para baixar uma glicemia elevada até valores normais.

L
Ligação  Para ligar e configurar a opção de medição que permite que 
a bomba receba leituras de GS a partir do medidor CONTOUR® LINK, 
OneTouch® UltraLink™ ou Paradigm Link®.

É ainda usada neste sistema como sinónimo de hiperligação. Ao clicar 
na ligação de hipertexto, o utilizador é levado a outro ponto no sistema 
ou a outro sítio da Web.

M
Medidor dispositivo médico para determinar a concentração 
aproximada da glicemia. Uma pequena gota de sangue é colocada 
numa tira de teste descartável; o medidor de glicose no sangue 
efectua a leitura da tira e usa esta leitura para calcular o nível de 
glicemia. O medidor mostra então o nível em mg/dl ou mmol/l. 

μl  microlitro  

O
Opção do medidor  Função que permite à bomba de insulina receber 
leituras de GS a partir de um medidor de GS ligado.
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P
Padrão A/B:  Padrão basal que suporta níveis de actividade que não 
fazem parte da sua rotina diária habitual, mas que são normais no 
seu estilo de vida. Estas actividades podem ser um desporto que 
o utilizador pratica uma vez por semana ou uma mudança no padrão 
de sono ao fim-de-semana, períodos alargados de maior ou menor 
actividade ou regras menstruais.

Padrão standard  O padrão basal normal que suporta a sua actividade 
diária habitual. Quando a função Padrões está desactivada, a bomba 
utiliza o seu padrão standard (basal).

Padrões basais  O utilizador pode programar até três padrões 
diferentes de índice basal na sua bomba para a administração da 
insulina basal: Padrão, A e B. Para cada padrão, é possível configurar 
até 48 índices basais.

Perfil basal  Índice basal com hora de início e de fim. O utilizador 
pode programar vários perfis diferentes na bomba de insulina, cada 
um dos quais com um índice basal diferente, durante um período de 
24 horas, para alcançar um melhor controlo da glicemia.

R
RF  Radiofrequência (RF). 

S
Sensibilidade à insulina  Quantidade em mg/dl (ou mmol/l) da 
redução do seu nível de glicemia (GS) conseguida com uma unidade 
de insulina. (Dados do Bolus Wizard.)

Suspender  Função que interrompe toda a administração de insulina 
pela bomba. Todas as actuais administrações de bolus e/ou enchimentos 
são canceladas. A administração do índice basal é colocada em pausa 
até ser retomada. 

T
Taxa carb (Taxa de carbohidratos)  A quantidade de carbohidratos 
compensada por uma unidade de insulina. (Ver também Taxa porção.)

Taxa prç (Taxa de porções)  Quantidade de insulina necessária para 
compensar uma (1) porção de carbohidratos. (Ver também Taxa carb.)

Temp  Temporário.

Teste às cetonas  As cetonas são resíduos produzidos no corpo quando 
este é forçado e queimar gordura em vez de glicose para obter energia. 
Pode ser um sinal de falta de insulina no corpo. A análise às cetonas 
mede a quantidade de cetonas concentradas no sangue ou urina.

U
Unidades de carbohidratos  A ingestão de alimentos ao utilizar Bolus 
Wizard. Introduzida como gramas ou porções (de carbohidratos).
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